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1
Introduction
CAD Documentation

The following documents contain additional information about CAD 7.0:

■ Cisco CAD Installation Guide

■ Cisco Desktop Administrator User Guide

■ Cisco Agent Desktop User Guide

■ Cisco IP Phone Agent User Guide

■ Cisco Supervisor Desktop User Guide

■ Cisco Agent Desktop—Browser Edition User Guide

■ Configuring and Troubleshooting VoIP Monitoring

■ Integrating CAD with Citrix Presentation Server or Microsoft Terminal Services

■ Cisco CAD Error Code Dictionary
7
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CAD 7.0 Applications

CAD 7.0 includes the following applications:

User Applications

■ Cisco Desktop Administrator (Desktop Administrator)

■ Cisco Agent Desktop (Agent Desktop)

■ Cisco Agent Desktop—Browser Edition (CAD-BE)

■ Cisco Supervisor Desktop (Supervisor Desktop)

■ Cisco IP Phone Agent (IP Phone Agent, IPPA)

Services

■ Cisco Browser and IP Phone Agent Service (BIPPA service)

■ Cisco Desktop Agent E-Mail Service (Agent E-Mail service)

■ Cisco Desktop Call/Chat Service (Call/Chat service)

■ Cisco Desktop Enterprise Service (Enterprise service)

■ Cisco Desktop LDAP Monitor Service (LDAP Monitor service)

■ Cisco Desktop Licensing and Resource Manager Service (LRM service)

■ Cisco Desktop Recording and Statistics Service (Recording and Statistics 
service)

■ Cisco Desktop Recording Service (Recording service)

■ Cisco Desktop Sync Service (Sync service)

■ Cisco Desktop VoIP Monitor Service (VoIP Monitor service)

■ Directory Services
8 August 6, 2012



Version Information
Version Information

All CAD applications include version information. This can be obtained by:

■ Checking the About dialog box (choosing Help > About on desktop application 
menu bars)

■ Right-clicking the application executable and selecting Properties from the 
resulting menu

■ Opening *.jar and *.war files with Winzip and locating the Mainifest.mf file, 
which contains version information

Version information is a series of four numbers separated by periods (for example, 
6.6.1.15). From left to right, these represent:

■ The major feature version number

■ The minor feature version number

■ The service level (maintenance) number

■ The build number 
August 6, 2012 9



Cisco CAD Troubleshooting Guide
10 August 6, 2012



August 6, 2012
2
Capacity and Performance 
Guidelines
Directory Services 
Replication/Synchronization

The Replication Process

The LDAP Monitor service manages setting up the configuration for Directory Services 
replication and resynchronizing the Directory Services data.

Whenever a second Unified CCX engine is activated in Unified CCX Administration, 
replication setup and synchronization occurs. This process takes up to five minutes 
(depending on the size of Directory Services and the network performance between 
the two machines). During this process, Directory Services is temporarily unavailable 
even though it is shown as “started” in the Windows Services window and “active” in 
Unified CCX Administration.

Whenever one of the Unified CCX engines is deactivated in Unified CCX 
Administration, the replication teardown process occurs. Directory Services becomes 
temporarily unavailable during this process, just as it does during the 
setup/synchronization process. The teardown process takes approximately one 
minute or less.

To avoid corrupting Directory Services, do not:

■ Shut down the LDAP Monitor service during the replication/synchronization 
setup or teardown process.

■ Deactivate a Unified CCX node before the replication/synchronization setup 
process is completed on a Unified CCX node you have just activated.

How can you tell if Directory Services is corrupted?

Indications that Directory Services has become corrupted are:

■ The LDAP Monitor service is running, but the slapd process from Windows 
Task Manager is not.
11
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■ The LDAPMonSvr.log displays a message that DBRecovery (database 
recovery) has failed.

How can you correct a corrupted Directory Services?

To correct a corrupted Directory Services database, follow these steps:

1. Stop the LDAP Monitor service on both the machine hosting the corrupted 
Directory Services database and the machine hosting the replicated, 
uncorrupted Directory Services database.

2. On the machine hosting the corrupted Directory Services database, remove 
all files from the folder …/Desktop/database.

3. On the machine hosting the uncorrupted Directory Services database, copy all 
files from the folder …/Desktop/database and then paste them into the same 
folder on the machine hosting the corrupted database.

4. Restart the LDAP Monitor service on both machines.

Reading the LDAPMonSvr.log

The LDAPMonSvr.log file records the start and end time of a 
replication/resynchronization cycle. Consult this log file to find out the amount of time 
your system takes to carry out this process.

The following are examples of the start and end time entries in the LDAPMonSvr.log 
file:

13:32:56 09/08/2004 INFO   LM0000  Replication request from 
:192.168.252.65_204402064532456

13:33:08 09/08/2004 INFO   LM0000  Replication request from  
:192.168.252.65_204402064532456  successful
12 August 6, 2012
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Service Autorecovery

Fault Tolerance

CAD 7.0 uses the “warm standby” approach to fault tolerance and autorecovery. No 
manual intervention is required to recover a failed service.

Data and features might be lost at the time of the failure. For instance:

■ Active monitoring is stopped. It can be restarted manually after the failover.

■ Enterprise data for the call in progress is lost at the time of the failure.

All CAD features are fault-tolerant to a single point of failure with several exceptions. 
They are:

■ Playback. Recordings are tied to a specific service, and thus are not 
replicated.

■ SPAN-based monitoring and recording. If fault tolerance is required, desktop 
monitoring can be used for agents who use Agent Desktop only. Desktop 
monitoring is not supported for agents who use IPPA or CAD-BE.

NOTE:  If any (but not all) VoIP monitor service nodes are down, 
agents and supervisors will see partial service for monitoring and 
recording. This is because, for SPAN-based recording, all VoIP 
services are active and are solely responsible for hte devices that 
have been assigend to them in Cisco Desktop Administrator and in 
the SPAN port configuration on the Catalyst switch. If a VoIP Monitor 
service is unavailable, then monitoring and recording will be 
unavailable for those agents in a SPAN-based deplyment. Supervisor 
and agent desktop will reflect this by showing partial service for those 
features.

CAD uses LDAP replication to provide fault tolerance for configuration information, 
such as work flows, agent hot seat settings, and so on. It uses SQL server for Unified 
CCX merge replication to provide fault tolerance for Recording and Statistics 
service-related data, such as call logs, agent state logs, recording logs, and so on.

A subset of the base services fail over together. These services will either all be active 
or all be inactive on the same box:

■ Agent E-Mail service

■ Call/Chat service

■ Enterprise service

■ LRM service
August 6, 2012 13
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■ Sync service

■ Recording and Statistics service

■ BIPPA service

Agent Desktop, Supervisor Desktop, and CAD-BE

The service autorecovery feature enables Agent Desktop, Supervisor Desktop, and 
CAD-BE to automatically recover their connections to the Desktop Services in the case 
of a service restart or a network outage. 

When Agent Desktop, CAD-BE, or Supervisor Desktop detects that it is unable to 
communicate with a service (generally within one minute of the service failure), the 
application status bar displays “Partial Service” or “No Service” to indicate some or all 
of the services have failed. 

When Agent Desktop, CAD-BE, or Supervisor Desktop detects that the service is again 
available (usually within one minute of service recovery), the status bar displays “In 
Service” to indicate the services have recovered.

To learn more about what is affected by the service failure, double-click the status 
message on the status bar. The application displays a popup box that lists the 
application features and indicates if that feature is available or not due to the service 
outage.

BIPPA Service

The BIPPA service pushes an error screen to all agents logged into IP Phone Agent 
when it detects a failover in Unified CCX. During the time it is unable to communicate 
with Unified CCX, any attempt to change agent state or perform another IP Phone 
Agent function returns the service error screen.

Once the BIPPA service is able to reconnect to Unified CCX, it pushes one of the 
following screens to the agent’s phone:

■ The Login screen, if the agent in not logged into Unified CCX

■ The Skill Statistics screen, if the agent is still logged into Unified CCX

VoIP Monitor Service

VoIP Monitor service recovery is a special case, since more than one VoIP Monitor 
service can be installed in a single logical contact center. Supervisor Desktop is 
notified when one VoIP Monitor service in a multiple VoIP Monitor service 
configuration goes down. However, agent monitoring is not disabled because it is not 
14 August 6, 2012
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possible to tell which agents are monitored by which VoIP Monitor service. The only 
indication a supervisor receives that a particular agent is assigned to the downed VoIP 
Monitor service is an error message when attempting to monitor that agent. 

NOTE:  This does not apply to desktops with desktop monitoring 
enabled.

Agent E-Mail Service

The Agent E-Mail service connects to a single e-mail server. If the e-mail server is 
down the Agent E-Mail feature will not function.
August 6, 2012 15
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Guidelines for Sizing Deployments

Service capacities vary based on the total number of agents in a contact center and 
whether or not silent monitoring and recording are required. 

NOTE:  The following guidelines are based on testing with a 
combination of real and simulated agents.

Component Sizing

The Desktop base services consist of a set of services that run as Window services. 
The base services include:

■ Agent E-Mail service

■ BIPPA service

■ Call/Chat service

■ Directory Services

■ Enterprise service

■ LDAP Monitor service

■ LRM service

■ Recording and Statistics service

■ Sync service

There are other services that can be placed on the same or separate computer as the 
base services. These include:

■ VoIP Monitor service

■ Recording service

The maximum number of agents that can be supported by a single Logical Call Center 
(LCC) is 300 (approximately 4,500 Busy Hour Call Completion [BHCC] with a call 
volume of 20 calls per agent per hour).
16 August 6, 2012



August 6, 2012
3
Technical Package Information
Service Connection Types and Port Numbers

Consult the Cisco Unified CCX (IP IVR and IPCC Express) Port Utilization Guide for a 
complete listing of ports and connection types used in CAD 7.0.
17
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Registry Entries

Site Setup

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\Site Setup

Table 1. Site setup registry entries 

Key Value Type Description

Site 
Setup

APP VERSION string Used by installation scripts to 
identify the version of the service 
software.

CALLCENTERLANG string Language selected during 
installation.

DEPLOYTYPE string Defines the Unified CM type.

INSTALL 
DIRECTORY

string Base install directory for Cisco 
software.

INSTALLDIR string Parent directory of base install 
directory for Cisco software.

IOR HOSTNAME string Hostname or IP address of the 
computer’s NIC. Its value is only 
present on the CAD services 
computer.

LDAP Bind DN string User ID used to log in to the LDAP 
service. Default = cn=Client, 
ou=People, o=Spanlink 
Communications.

LDAP Connection 
Timeout

dword Maximum time, in seconds, 
before a connection attempt 
times out. Default = 15.

LDAP Heartbeat 
Enabled

dword Is heartbeat enabled? 1=yes, 
0=no. Default = 1.

LDAP Heartbeat 
Retry Time

dword Heartbeat time, in milliseconds. 
Default = 10000.

LDAP Host 1 string LDAP service hostname/IP 
address. There can be multiple 
LDAP hosts.

LDAP LCC string Default logical contact center
18 August 6, 2012



Registry Entries
BIPPA

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\IPPA\

Site 
Setup

LDAP Port 1 dword LDAP service port. There can be 
multiple LDAP ports. Default = 
38983.

LDAP Pwd string Encrypted user password

LDAP Recovery 
Retry Time

dword Recovery retry time, in 
milliseconds. Default = 3000.

LDAP Request 
Timeout

dword Maximum time, in seconds, 
before an LDAP request times 
out. Default = 15.

LDAP Root string Root of the LDAP data. Default = 
o=Spanlink Communications.

MONITOR DEVICE string Network card on which to sniff 
packets.

ProductCode_
Agent

string Cisco Agent Desktop product 
code.

ProductCode_
Supervisor

string Cisco Supervisor Desktop 
product code.

ProductCode_
Admin

string Cisco Desktop Adminsitrator 
product code.

Serial Number dword Counter to indicate changes to 
site setup values. Default = 0.

Table 1. Site setup registry entries — Continued

Key Value Type Description

Table 2. BIPPA service registry entries 

Key Value Type Description

config TOMCAT HOME string Location of the Tomcat web 
server files. Default = C:\Program 
Files\wfavvid\tomcat_appadmin\
August 6, 2012 19
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Enterprise Service

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\Enterprise Server\

Table 3. Enterprise Service registry entries 

Key Value Type Description

Setup Max Wait Time*

* These registry keys need to be created only if there are timing issues when an agent 
requests data from the Enterprise service and the Enterprise service does not have the 
data yet.

dword Maximum time, in milliseconds, to 
wait for enterprise data. Default = 
100.

Initial Time* dword Number of milliseconds to wait after 
the first request for enterprise data, if 
data is not guaranteed. Default = 10.

Increment* dword Number of milliseconds to add to the 
retry time at each interval, if data is 
not guaranteed. Default = 20.

Retry Sleep 
Interval*

dword Number of milliseconds used to 
calculate the interval for retry 
attempts, if call is not known to 
enterprise. The interval is calculated 
by (retry sleep interval × retry 
attempt). Default = 150.

config JavaClassPath REG_SZ Lists jar files required by the Agent 
E-Mail service Java engine. Default: 
“log4j.jar,SplkStd4J.jar; 
EEM.jar;activation.jar;mail.jar”

JavaHome REG_SZ The path to the Java virtual machine 
that will be used for starting the 
E-Mail service Java engine. Default: 
“C:\Program Files\Java\jre1.5.0_14”

JavaVMArguments REG_SZ Additional arguments for the Java 
virtual machine. Default: '''' (empty 
string)
20 August 6, 2012
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Recording & Playback Client

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\Recording & Playback Client\

Table 4. Recording Client registry entries 

Key Value Type Description

Setup From Client Port dword The port on the supervisor’s desktop that 
is used to receive the “From Agent” audio 
stream for playback sessions.

Jitter Buffer dword The amount of voice data to buffer before 
playing. Default value = 1000 ms. On a 
typical internal network, this value can be 
set as low as 50 ms. The default is set 
higher so that the sound quality is good 
even on a congested network.

Port Range End dword End of range of port numbers to use for 
recording. Each simultaneous recording 
requires two ports.

Port Range Start dword Start of range of port numbers to use for 
recording. Each simultaneous recording 
requires two ports.

Sound Buffers dword The number of buffers used to hold audio 
data sent to the sound card. Default is 10. 
If sound quality is bad, increasing this 
number may improve the quality.

To Client Port dword The port on the supervisor’s desktop that 
is used to receive the “To Agent” audio 
stream for playback sessions.

VPN Port dword The port used by the Recording service for 
its VPN address service that client 
applications use to determine their visible 
IP address used by other clients and 
services. Do not change this entry unless 
you change the corresponding entry for 
the Recording service.
August 6, 2012 21
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Recording & Playback Service

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\Recording & Playback Server\

Table 5. Recording service registry entries 

Key Value Type Description

Config Audio Directory string The full path to the directory that 
will hold the audio files of 
recorded calls. Change this value 
only if the default directory 
cannot be used.

Setup IOR HostName string The client-visible IP address of 
this machine, used by the service 
to construct its connection string 
that is used by the clients.

Maximum 
Playbacks

dword Maximum concurrent playbacks

Maximum 
Recordings

dword Maximum concurrent recordings

OmniOrbUsePort dword The CORBA port on which the 
Recording service listens for 
client requests.

VPN Port dword The port on which the Recording 
service listens for requests from 
clients for their visible IP address. 
If you change this entry, you must 
also change the corresponding 
entry for all of the client 
applications.
22 August 6, 2012



Registry Entries
Recording and Statistics Service

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\RASCAL Server\

Table 6. Recording and Statistics service registry entries 

Key Value Type Description

Config DB SCRIPT 
MESSAGE

string Error message used by technical 
support for troubleshooting.

DB SCRIPT 
RESULT

string The Boolean result returned after 
running the Recording and 
Statistics service set up script. 1 
= Completed successfully. 0 = 
error.
August 6, 2012 23
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VoIP Monitor Client

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\VoIP Monitor Client\

Table 7. VoIP IP Monitor Client registry entries 

Key Value Type Description

Config FROM AGENT 
PORT

dword IP port for RTP stream being sent 
from IP agent. Default value = 
59012. Port must be an even 
number. The next port is reserved 
for RTCP stream.

JITTER BUFFER dword The amount of voice data to 
buffer before playing. Default 
value = 400 ms. On a typical 
internal network this value can be 
set as low as 50 ms. The default 
is set higher so the sound quality 
is good even on a congested 
network.

SERVER HOST string Host name of the VoIP service.

SOUND BUFFERS dword Number of sound card buffers. 
Default = 30; minimum is 3. If the 
monitor sound quality is choppy, 
stuttering, or like a motorboat you 
might be able to make it sound 
better by adjusting this value 
higher. Setting the value higher 
increases the sound lag, and 
might cause a slight stutter at the 
beginning of a monitor session.

TO AGENT PORT dword IP port for RTP stream being sent 
to Agent IP Phone. Default value = 
59010. The port must be an even 
number. The next port is reserved 
for RTCP stream.
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Registry Entries
VoIP Monitor Service

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\VoIP Monitor Server\

VoIP Monitor Record Client (Optional)

These registry entries should not be needed because the VoIP Monitor API has built-in 
defaults. They can be used to override the defaults. 

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\VoIP Monitor Client 

Table 8. VoIP Monitor Service registry entries 

Key Value Type Description

Config App Version string Used by installation scripts to 
identify the version of the service 
software. The service itself does 
not use this entry.

Update Version string Future use: tracks any hot fixes 
installed.

Monitor Device string Network card on which to sniff 
packets.

Table 9. VoIP Monitor Client registry entries 

Key Value Type Description

Setup Recording Jitter 
Buffer

dword The number of milliseconds that a 
packet expires for recording.

Recording Port 
Range Start

dword The starting port number for 
receiving UDP packets for 
recording.

Recording Port 
Range End

dword The end port number for receiving 
UDP packets for recording.
August 6, 2012 25
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4
Configuration Files, Logs, and 
Debugging
Introduction

CAD events and errors are recorded in log files. CAD services and desktop 
applications can be configured by modifying the appropriate configuration file. 

This chapter contains information about the following topics.

■ Event, Error, and Chat Logs (page 28)

■ Configuration Files (page 32)

■ Debugging Logs (page 34)
27
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Event, Error, and Chat Logs

Logs are listings of CAD events, errors, and chat messages. Event, error, and chat 
message logging is always enabled. 

Events may represent the following:

■ Actions taken by a Desktop application

■ Implications of user-defined configuration settings

■ Limitations of the hardware

Error codes are brief descriptions of system events.

The CAD Chat client logs all agent-to-agent, agent-to-supervisor and agent-to-SME 
chat messages. One file is created for each day of the week. Logs are saved in the 
folder C:\Program Files\Cisco\Desktop\log\transcripts on the client computer for one 
week. To view a log, you must log onto the client computer.

Event and error log files are limited to a default of 3 MB. (You can change the limit in 
the application’s configuration file. When a log file reaches that size, it is closed and a 
new file is started. Event and error log files are numbered, up to the total number of 
files set in the configuration file (the default number is 2). For example:

■ agent0001.log

■ agent0002.log

When agent0001.log reaches its size limit, it is closed and agent0002.log is created. 
When the total number of log files have been created, the first log file is overwritten.

Table 10 lists the event, error, and chat message logs generated by CAD.  

Table 10. CAD event, error, and chat message logs 

Service/Application Log Name

Agent Desktop agent.log

Backup and Restore utility CDBRTool.log

BIPPA service IPPASvr.log

BIPPA service JSP client IPPAClient.log

CAD Configuration Setup PostInstall.log

CAD uninstall process fcuninstall.log

CAD-BE CadBE.log
28 August 6, 2012
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Chat client monday.txt, tuesday.txt, wednesday.txt, 
thursday.txt, friday.txt, saturday.txt, 
sunday.txt

Chat service FCCServer.log

Desktop Administrator:
Desktop Configuration

administrator.log

Desktop Administrator:
Enterprise Data Configuration

TSSPAdm.log

Desktop Administrator:
framework

Splkview.log

Desktop Administrator:
Unified CCE Configuration

IPCCAdm.log

Desktop Administrator:
Personnel Configuration

personnel.log

Desktop Monitoring Console SMC.log, SMCGetServerList.log

Directory Services slapd.log

Directory Services Replication slurpd.log

Enterprise service CTIStorageServer.log, WorkflowEngine.log

LDAP Monitor service LDAPMonSvr.log

License Administrator LicensingAdmin.log

LRM service LRMServer.log

OpenLDAP openldap.log

Recording & Playback service RPServer.log

Table 10. CAD event, error, and chat message logs — Continued

Service/Application Log Name
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Cisco Agent Desktop Chat Logs

All Agent Desktop chat conversations are automatically archived in plain text log files 
and kept for one week. The logs are saved to the following folder on the agent’s 
computer:

Recording and Statistics service • FCRasSvr.log
• db.cra_repl_ads.pub.sql.log
• db.cra_repl_ads.sql.log
• db.cra_repl_ads.sub.sql.log
• db.cra_repl_base.fcrassvr.pub.sql.log
• db.cra_repl_base.fcrassvr.sql.log
• db.cra_repl_base.fcrassvr.sub.sql.log
• db.cra_utils_base.fcrassvr.pub.sql.log
• db.cra_utils_base.fcrassvr.sql.log
• db.cra_utils_base.fcrassvr.sub.sql.log
• db.instrasdb.fcrassvr.pub.sql.log
• db.instrasdb.fcrassvr.sql.log
• db.instrasdb.fcrassvr.sub.sql.log
• db.repl_base.pub.sql.log
• db.repl_base.sql.log
• db.repl_base.sub.sql.log
• db.sp_make_

publisher.fcrassvr.pub.sql.log
• db.sp_make_

publisher.fcrassvr.sub.sql.log
• db.sp_splk_drop_

publisher.fcrassvr.pub.sql.log
• db.sp_splk_drop_

publisher.fcrassvr.sub.sql.log
• db.sql.log
• db.truncate.fcrassvr.pub.sql.log
• db.truncate.fcrassvr.sub.sql.log

NOTE:  The db.*.log files exist only in 
systems that use SQL Server.

Supervisor Desktop, 
Supervisor Record Viewer

supervisor.log

Supervisor Workflow Administrator SWFAdmin.log

Sync service DirAccessSynSvr.log

VoIP Monitor service FCVoIPMonSvr.log

Table 10. CAD event, error, and chat message logs — Continued

Service/Application Log Name
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C:\Program Files\Cisco\Desktop\log\transcripts\

There is one log per day (named monday.txt, tuesday.txt, and so on). The files are 
overwritten every week. The log includes the following information for every chat 
message:

■ Date

■ Time

■ Priority (0 for normal, 1 for high priority)

■ Type (message to supervisor, message to user)

■ Sender

■ Recipient

■ Message text
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Configuration Files

Table 11 lists the configuration files used by CAD services and applications. For 
instructions about how to modify one of these configuration files to enable debugging, 
see "Debugging Logs" on page 34.  

Table 11. CAD configuration files 

Application/Service Configuration File

Agent Desktop agent.cfg 

Agent E-Mail feature on agent 
desktop

EemApp.properties

Agent E-Mail service EEMServer.cfg

Agent E-Mail service Java engine EEMServerJava.properties

Backup and Restore utility bars.properties

BIPPA service IPPASvr.cfg

BIPPA service JSP client IPPAClient.properties 

CAD-BE CadBE.properties

Call/Chat service FCCServer.cfg

Desktop Administrator

• Browser-based application

• Desktop application (workflow)

Administrator.cfg 

• WebAdminLib.cfg, WebAdmin.properties

• SplkUpdate.cfg

Directory Services slapd.cfg

Directory Services Replication slurpd.cfg

Enterprise service CTIStorageServer.cfg

LDAP Monitor service LDAPMonSvr.cfg

LRM service LRMServer.cfg

Recording and Statistics service FCRasSvr.cfg

Recording service RPServer.cfg

Supervisor Desktop Supervisor.cfg

Supervisor Record Viewer SupervisorLogViewer.cfg 

Supervisor Workflow Administrator SWFAdmin.cfg

Sync service DirAccessSynSvr.cfg
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Configuring the Recording and Statistics Service

You can choose to include or exclude outbound calls in call totals that are displayed in 
agent call logs and statistics reports. The default behavior is for outbound calls to be 
excluded from the total number of calls presented and handled. You can change this 
behavior so that outbound calls are included in the total number of calls presented 
and handled. Table 12 summarizes the default and configured behavior settings. 

To include oubound calls in totals:

1. Navigate to C:\Program Files\Cisco\Desktop\config.

2. Open FCRasSvr.cfg.

3. Add the following lines to the configuration file:

[ReportParameters]
CallReportIncludesOutbound=1

4. Save the configuration file with the new setting. The new setting will go into 
effect when you restart the Recording and Statistics service.

VoIP Monitor service FCVoIPMonSvr.cfg

Table 11. CAD configuration files — Continued

Application/Service Configuration File

Table 12. Outbound call statistic handling

Total

Outbound Calls

Default behavior Configured behavior

Calls Presented Not counted Counted

Calls Handled Not counted Counted if answered
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Debugging Logs

CAD can create debugging logs, although by default this capability is disabled. If you 
want debugging turned on, you must edit the appropriate configuration file. 

NOTE:  When upgrading from CAD 6.4 to CAD 7.0, any configuration 
files you edited revert to their default settings.

Debugging information is written to the various debug files, all of which have a *.dbg 
suffix. The debugging files for all applications and services are located in C:\Program 
Files\Cisco\Desktop\log. Exceptions are:

■ BIPPA service JSP and Desktop Administrator debugging logs are located in 
C:\Program Files\wfavvid\tomcat_appadmin\log on the CAD services server

■ CAD-BE on Linux debugging logs are located in the agent’s home directory

■ CAD-BE on Windows debugging logs are located on the agent’s Windows 
desktop

The debug files are numbered, up to the total number of files set in the configuration 
file (the default number is 2). For example:

■ agent0001.dbg

■ agent0002.dbg

When agent0001.dbg reaches its size limit, it is closed and agent0002.dbg is created. 
When the total number of debug files have been created, the first debug file is 
overwritten.

Turning on Debugging

To enable debugging for CAD-BE, you must download the CadBE.properties file to the 
computer on which CAD-BE will be run, then edit the downloaded properties file to 
select the desired threshold. For instructions, see the following sections.

■ Downloading the CadBE.properties File (page 35)

■ Enabling Debugging for Java Applications (page 36)

To enable debugging for all other CAD services and applications, you must edit the 
appropriate configuration file on the computer on which the CAD services are 
installed. For instructions, see the section that corresponds to the service or 
application that you are configuring.

■ For IPPA, see "Enabling Debugging for Java Applications" on page 36.
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■ For Desktop Administrator, you must edit two configuration files, 
WebAdmin.properties and WebAdminLib.cfg. For WebAdmin.properties, see 
"Enabling Debugging for Java Applications" on page 36. For WebAdminLib.cfg, 
see "Enabling Debugging for non-Java Applications" on page 37.

■ For all other CAD services and applications, see "Enabling Debugging for 
non-Java Applications" on page 37.

For a complete list of services/applications and their corresponding configuration 
files, see Table 11 on page 32. 

Downloading the CadBE.properties File

To download the CadBE.properties file:

1. Open your web browser and access Unified CCX Administration using the 
following URL. The Unified CCX Administration Authentication page appears.

http://<Unified CCX server IP address or hostname>/appadmin

2. At the prompt, enter your username and password, then click Log On. The 
Unified CCX Administration home page appears.

3. Choose Tools > Plug-ins.

4. On the Plug-ins page, click the Cisco Unified CCX Desktop Suites link.

5. Right-click the hyperlink labeled CAD-BE logging and debugging file and save 
it to your computer. Table 13 gives the location in which the CadBE.properties 
file should be saved and any additional actions that need to be completed, 
depending on the operating system and browser you are using.

Table 13. Properties file location and additional actions

Operating
System Browser Location of properties file/additional actions

Windows Vista Internet Explorer Save the properties file to the desktop. In 
addition, add the CAD-BE server hostname or 
IP address to the Internet Explorer list of 
trusted sites.

Windows Vista Mozilla Firefox Save the properties file to the desktop. In 
addition, change the Mozilla Firefox “Start In” 
directory to the desktop.

Windows XP Internet Explorer Save the properties file to the desktop.

Windows XP Mozilla Firefox Save the properties file to the folder in which 
Mozilla Firefox is installed. The default is 
C:\Program Files\Mozilla Firefox.

Linux Mozilla Firefox Save the properties file to your home directory.
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Debugging Thresholds

When setting the debugging threshold, keep in mind that the more detail the 
threshold provides, the slower the performance of your PC and increases the size of 
the debug file. Table 14 lists the available debugging thresholds.

Enabling Debugging for Java Applications

To enable debugging for Java applications:

1. Navigate to the appropriate folder. 

■ For CAD-BE, navigate to the folder specified in "Downloading the 
CadBE.properties File" on page 35.

■ For the Agent E-Mail service Java engine, navigate to the folder 
C:\Program Files\Cisco\Desktop\config.

■ For the Agent E-Mail applet, navigate to the folder
C:\Program Files\Cisco\Desktop\config.

■ For all other Java applications, navigate to the folder 
C:\Program Files\wfavvid\tomcat_appadmin\conf.

2. Open the properties file. The file contains one or more of the following 
debugging statements at the beginning of the file.

Table 14. Debugging thresholds 

Threshold Events Recorded

Debug • Minor and frequently-occurring normal events. This level is usually 
sufficient for debugging a problem, and will not affect the 
computer’s performance.

Call • Minor and frequently-occurring normal events

• Entering and exiting functions

Trace • Minor and frequently-occurring normal events

• Entering and exiting functions

• Detail debugging (for instance, loops)

Dump • Minor and frequently-occurring normal events

• Entering and exiting functions

• Detail debugging (for instance, loops)

• Byte dumps

Off Turns off debugging. This is the default setting.
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#log4j.rootLogger=INFO,LOG,DBG
log4j.rootLogger=DEBUG,LOG,DBG
#log4j.rootLogger=CALL#com.spanlink.util.log.SplkLevel,LOG,DBG
#log4j.rootLogger=TRACE,LOG,DBG
#log4j.rootLogger=DUMP#com.spanlink.util.log.SplkLevel,LOG,DBG

3. Add the character ‘#’ to the beginning of the existing debugging threshold 
statement. Then either add a new debugging threshold statement or remove 
the character ‘#’ at the beginning of the desired debugging threshold 
statement if it already exists.

For example, to select the Call debugging threshold, add ‘#’ to the existing 
debugging threshold statement. Then either add the third statement or 
remove ‘#’ from the beginning of the third statement if it already exists.

#log4j.rootLogger=INFO,LOG,DBG
#log4j.rootLogger=DEBUG,LOG,DBG
log4j.rootLogger=CALL#com.spanlink.util.log.SplkLevel,LOG,DBG
#log4j.rootLogger=TRACE,LOG,DBG
#log4j.rootLogger=DUMP#com.spanlink.util.log.SplkLevel,LOG,DBG

4. Save the configuration file with the new setting. You must restart the 
application to make the new setting take effect.

Enabling Debugging for non-Java Applications

To enable debugging for non-Java applications:

1. Navigate to C:\Program Files\Cisco\Desktop\config.

2. Open the appropriate configuration file.

3. Under the section headed [Debug Log], set the debugging threshold to an 
appropriate value. For more information, see "Debugging Thresholds" on 
page 36. For example:

Threshold=DEBUG

4. Save the configuration file with the new setting. You must restart the service 
or application to make the new setting take effect.
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5
Troubleshooting
Services

Restarting Services

If you have to stop the services, you can restart them in any order through the 
Unified CCX Administration application.

Service Names/Executables

To find out whether a service is running, use the Unified CCX Administration Control 
Center or open the Microsoft Windows Services Control Panel. 

Table 15. Service names and executables 

Service name as shown in Services Control Panel Executable

Cisco Browser and IP Phone Agent Service IPPASvr.exe

Cisco Desktop Agent E-Mail Service EEMServer.exe

Cisco Desktop Call/Chat Service FCCServer.exe

Cisco Desktop Enterprise Service CTIStorageServer.exe

Cisco Desktop LDAP Monitor Service LDAPmonSvr.exe, 
slapd.exe,
slurpd.exe

Cisco Desktop Licensing and Resource Manager Service LRMServer.exe

Cisco Desktop Recording and Statistics Service FCRasSvr.exe

Cisco Desktop Recording Service RPServer.exe

Cisco Desktop Sync Service DirAccessSynSvr.exe

Cisco Desktop VoIP Monitor Service FCVoIPMonSvr.exe
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Converting Recordings From *.raw to *.wav 
Format

Recordings made by supervisors are archived as raw voice data packets; they can only 
be reviewed using the Supervisor Record Viewer. However, if you wish to permanently 
save selected recordings as .wav files, you can use either of two methods:

■ Using the “Play and Save” button in Supervisor Record Viewer and saving the 
recording to a selected folder

■ Using the Unified CCX raw2wav.exe command line utility

See the Cisco Supervisor Desktop User Guide for information on saving recordings as 
*.wav files through Supervisor Record Viewer.

Using the Unified CCX raw2wav Utility

This utility is located in the C:\Program Files\Cisco\Desktop\bin folder. It must be run 
from this location in a command window on the computer that hosts the Recording 
service (RPServer.exe). 

Each .raw format recording is comprised of the following files:

■ <name>.to.raw, containing data sent to the agent phone

■ <name>.from.raw, containing data sent from the agent phone

You need use only one of the file pair when running the utility. The utility finds the 
other file and combines the two files into one .wav file named <name>.wav.

The naming convention used for <name> is as follows:

<YYYYMMDD><HHMMSS><counter><extension><agent ID>

where:

<YYYYMMDD>Date the file was recorded

<HHMMSS>Time the file was recorded

<counter>Counter that is reset every time the agent logs in. It is incremented 
sequentially starting from 00000 every time a recording of that agent is made 
during that session.

<extension>The extension of the agent recorded

<agent ID>The ID of the agent recorded
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The utility looks in the registry to find the location of the *.raw files. If this information 
is not in the registry, the utility assumes that the location is the folder 
C:\Program Files\Cisco\Desktop_Audio. The utility writes the converted *.wav files to 
a folder it creates located at C:\Program Files\Cisco\Desktop_wav.

The utility syntax is:

raw2wav.exe <filename>

where <filename> is either the <name>.to.raw or <name>.from.raw file.

Running Unified CCX raw2wav in a Batch File

You can use the Unified CCX raw2wav utility from a batch file that iterates through a 
wildcard-specified set of source files. 

If the utility finds a .wav file with a name identical to one that is about to be created, 
the conversion is not executed. 

NOTE:  If the utility is halted prematurely, the .wav file being written at 
that time may be corrupted.

A batch file is a text file with a *.bat extension. You can put DOS commands into this 
file and then run the file as if it were an executable.

For example, the following series of DOS commands can be put into a batch file called 
convert.bat:

c:\
cd c:\program files\cisco\desktop\bin
for %%c in (..\..\desktop_audio\*.raw) do Unified CCX raw2wav 
"%%~nc%%~xc"

These DOS commands cause all the *.raw files in the folder 
C:\Program Files\Cisco\Desktop_audio to be converted to *.wav format and placed in 
the folder C:\Program files\Cisco\Desktop_wav, leaving the original *.raw files in the 
Desktop_audio folder.

Additional lines can be added to the batch file to copy the files to another folder or file 
server. 

NOTE:  The utility has a feature that prevents it from reconverting files 
that are already present in the Desktop_wav directory, so the batch 
file does not have to explicitly check to see if the files have already 
been converted.
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If you want the batch file to run automatically on specific days at a specific time, the 
Windows “at” command can be used. 

For example, if you want convert.bat to run automatically every 13th and 23rd day of 
the month at 1:46 pm, do the following:

1. Put convert.bat in the C:\Program Files\Cisco\Desktop\bin folder.

2. Open a command window and enter the following DOS command:

at 1:46p /every:13,23 cmd /c "c:\program 
files\cisco\desktop\bin\convert.bat" ^> c:\splkconvert.txt
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ShowLicenseUsage Utility

NOTE:  This utility has not been tested thoroughly; it is provided on an 
as-is basis only

The ShowLicenseUsage utility can be run to view the IP addresses of clients that are 
consuming desktop seats or are running Cisco Desktop Administrator or Cisco 
Workflow Administrator.

For IP Phone Agent and CAD–BE seats, the IP address is the IP address of the active 
Browser and IP Phone Agent (BIPPA) service. For web-based Cisco Desktop 
Administrator, the IP address is the IP address of the CAD server.

ShowLicenseUsage.exe is run from the C:\Program Files\Cisco\Desktop\bin folder on 
the CAD server.

To use the ShowLicenseUsage utility:

1. On the server hosting the CAD services, open Windows Explorer.

2. Navigate to the C:\Program Files\Cisco\Desktop\bin folder. 

3. Double-click ShowLicenseUsage.exe to run the utility. A command window 
opens and displays the results (Figure 1).

Figure 1. ShowLicenseUsage utility results
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Entries in the command window are described in Table 16.

Table 16. ShowLicenseUsage result headings

Result Heading Description

admin - desktop Not used in this version.

admin - enterprise Lists users of Cisco Work Flow Administrator 
and Cisco Desktop Administrator.

admin - personnel Not used in this version.

admin - cti config Not used in this version.

seat Lists users of Cisco Agent Desktop, Cisco Agent 
Desktop—Browser Edition, Cisco IP Phone Agent, 
and Cisco Supervisor Desktop.
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Recovering the Directory Services Database

Corrupted Directory Services Database

If the Directory Services database becomes corrupted, follow these steps.

To recover the Directory Services database (Method 1):

1. On the PC hosting the database, stop the LDAP Monitor service. 

2. Open a command window.

3. Change directories to …Cisco\Desktop\bin (the drive and exact location of 
this directory depends on where the services were installed).

4. In the …Cisco\Desktop\bin directory, type the command:

db_recover -h ../database -v

and press Enter.

5. Type exit and press Enter to close the DOS window. 

6. Restart the LDAP Monitor service.

If this procedure does not work, follow these steps.

To recover the Directory Services database (Method 2):

1. On the PC hosting the database, stop the LDAP Monitor service. 

2. Open a command window.

3. Change directories to …Cisco\Desktop\bin (the drive and exact location of 
this directory depends on where the services were installed).

4. In the …Cisco\Desktop\bin directory, type the command:

slapcat -f slapd.conf -l backup.ldif -c

and press Enter.

5. Rename the existing folder …Cisco\Desktop\database to 
…Cisco\Desktop\old_database.

6. Create a new folder called Cisco\Desktop\database.

7. Copy DB_CONFIG and all files with a .dat extension from the old_database 
folder to the database folder.

8. In the database folder, create an empty file called rep.log.

9. Open a command window.

10. Change directories to …Cisco\Desktop\bin (the drive and exact location of 
this directory depends on where the services were installed).
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11. In the …Cisco\Desktop\bin directory, type the command:

slapadd -f slapd.conf -l backup.ldif -c

and press Enter.

12. Type exit and press Enter to close the DOS window. 

13. Restart the LDAP Monitor service.

Out of Sync Directory Services Databases

The secondary Directory Services database can become out of sync with the primary 
Directory Services database. A possible reason for this to occur is that the secondary 
database was reinstalled.

Follow these steps to sync up the two databases:

1. On the PC hosting the primary database, stop the LDAP Monitor service. 

The secondary LDAP can be down at this time.

2. Remove all contents from the files repl.log and repl.log.lock from the 
…\Cisco\Desktop\database folder.

3. Delete all files in the …\Cisco\Desktop\run\logs\replica, 
…\Cisco\Desktop\logs\replica, and …\Cisco\Desktop\logs\ReplLogs folders.

4. Open a command window on the primary database computer.

5. Change folders to …\Cisco\Desktop\bin (the drive and exact location of this 
folder depends on where the service was installed).

6. In the …\Cisco\Desktop\bin folder, type the command:

slapcat -f slapd.conf -l backup.ldif -c

and press Enter. A file called backup.ldif is generated.

7. Copy the backup.ldif file to the computer on which the secondary LDAP 
service is installed, into the …\Cisco\Desktop\bin folder.

8. On the PC hosting the secondary database, stop the LDAP Monitor service if it 
is not already stopped.

9. Remove all contents from the files repl.log and repl.log.lock from the 
…\Cisco\Desktop\database folder.

10. Delete all files in the …\Cisco\Desktop\run\logs\replica, 
…\Cisco\Desktop\logs\replica, and …\Cisco\Desktop\logs\ReplLogs folders.

11. To remove the secondary LDAP database, delete all files except the following 
files from the …\Cisco \Desktop\database folder:

■ case.dat

■ cmbcl.dat
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■ comp.dat

■ ctype.dat

■ decomp.dat

■ kdecomp.dat

■ DB_CONFIG

12. Open a command window on the secondary database computer.

13. Change folders to …\Cisco\Desktop\bin (the drive and exact location of this 
folder depends on where the service was installed).

14. In the …\Cisco\Desktop\bin folder, type the command:

slapadd -f slapd.conf -l backup.ldif -c

and press Enter.

15. Type exit and press Enter to close the DOS window.

16. Restart the LDAP Monitor service on the secondary computer.

17. Restart the LDAP Monitor service on the primary computer.
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Diagnostic Procedures

Should you have problems with any of the services, perform the following checks in 
the order they are presented here.

Basic Checks

When Agent Desktop has problems, check that:

■ The computers that host Agent Desktop services, unified CM, Unified CCX, 
and other system components are running.

■ The registry is correct (see "Registry Check" on page 51).

■ The network is set up correctly (see "Network Check" on page 51).

■ The Agent Desktop services are running and active (see "Active Service 
Check" on page 51).

■ The Agent Desktop Configuration Setup utility has run correctly. See the Cisco 
CAD Installation Guide for more information.

E-Mail Connectivity Check

If you are having trouble connecting to the Microsoft Exchange server, you should 
verify that the account is set up correctly by using Microsoft Outlook or telnet.

Before testing the connection ensure you have the following:

■ A Microsoft Exchange 2003 or 2007 server.

■ A server set up to allow IMAP connections. This may be a secure or a plain text 
connection.

■ A user account that can log into the IMAP server. This account must have an 
alias set up for each incoming e-mail address that you need for your call 
center.

NOTE:  Exchange 2007 does not properly handle e-mail aliases.  
While it will deliver them to the mail box, it will change the "To:" 
address back to the primary address for the account. The Agent 
E-Mail service needs a clean and unmodified "To" address in order to 
properly route e-mails. In order to get around this limitation, set up a 
distribution list for each incoming e-mail address with your Agent 
E-Mail service account as the only member.

■ An SMTP server. (This can be on the Exchange server or a separate server.)
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Testing Connections Using Outlook

You can configure Outlook to make an IMAP connection to the Exchange server; once 
connected you should be able to see folders and move messages around. You can 
also test the SMTP connection by sending a message from this account. Using 
Outlook, test the connection independently of the Agent E-Mail service and determine 
whether a connectivity issue is an Agent E-Mail issue or an Exchange configuration 
issue.

To configure an IMAP connection:

1. From the Outlook menu, choose Tools > E-mail Accounts. The E-mail Accounts 
wizard appears.

2. Select Add a new e-mail account, and then click Next. The E-mail Accounts - 
Server Type dialog box appears.

3. Select IMAP, and then click Next. The E-mail Accounts - Internet E-mail 
Settings (IMAP) dialog box appears.

4. Enter account information, and then click Next.

For detailed information on how to add users to Microsoft Exchange 2007, go to:

http://msexchangeteam.com/archive/2006/09/05/428833.aspx

Testing Connections Using Telnet

Perform the following steps to connect to IMAP using Telnet to test your e-mail 
connection.

1. Using Telnet, connect to IMAP by entering the following at a command 
prompt: 

telnet mail.myserver.com 143

The above command should display a response similar to the following:

telnet mail.myimapserver.com 143
Trying 192.168.1.1...
Connected to mail.myimapserver.com (192.168.1.1)
Escape character is '^]'
* OK IMAP4 ready

2. Log in using the login command. Type . login followed by your username and 
password, separated by spaces. If successful, a response similar to the 
following should appear:

. login accountname@myserver.com *********

. OK User logged in

If necessary, refer to the following link for more detailed information on 
connecting to IMAP using Telnet:

http://support.microsoft.com/kb/189326
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Connecting to SMTP using Telnet

1. Run the following command from the command line of your CAD server:

telnet mail.mysmtpserver.com 25

If successful, a response similar to the following should appear:

220 mail.mysmtpserver.com Microsoft ESMTP MAIL Service, 
Version: 6.0.3790.3959 ready at  Mon, 10 Dec 2007 16:53:25 -0600

2. Specify your mail server domain by typing the following into your telnet 
session using your mailserver domain:

EHLO mysmtpserver.com

If successful, the last line within the group of lines beginning with 250 should 
appear as follows:

    *
250 OK

3. Log into the SMTP server by typing AUTH LOGIN into your telnet session. The 
server responds with an encrypted prompt for your user name. Enter your 
username encrypted in base 64. The server responds with an encrypted 
base 64 prompt for your password. 

NOTE:  There are many tools online to do this. Perform a web search 
on the keywords: base64 converter.

4. Enter your password encrypted in base 64.

For example, if your username is <myname> and your password is 
<mypassword> the base64 conversions will be  bXluYW1l and  
bXlwYXNzd29yZA== respectively. A login sequence using these will look 
similar to the following:

AUTH LOGIN
334 VXNlcm5hbWU6
bXluYW1l
334 UGFzc3dvcmQ6
bXlwYXNzd29yZA==

If successful you will see the following:

235 2.7.0 Authentication successful.

5. You may also wish to test whether you can actually send an e-mail with this 
account by performing the following:

MAIL FROM:myname@mysmtpserver.com
250 2.1.0 myname@mysmtpserver.com....Sender OK
RCPT TO:recipient@mysmtpserver.com
250 2.1.5 recipient@mysmtpserver.com....Recpient OK
DATA
354 Please start mail input.
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Test of telnet smtp
.
250 Mail queued for delivery

You can find more information about testing SMTP communication using telnet at:

http://support.microsoft.com/kb/q153119/

http://technet.microsoft.com/en-us/library/aa995718.aspx

Active Service Check

This section applies to the following services only: Agent E-Mail, LRM, Call/Chat, 
Enterprise, Recording and Statistics, BIPPA, and Sync.

For Nonredundant Systems

■ Check the service log file for a statement that the service is active.

For Redundant Systems

■ Check the service log file for a statement that the service is active.

■ Only one instance of each service should be active at the same time. The 
other instance should be in standby mode.

Registry Check

Using Windows Regedit:

■ Verify that HKEY_LOCAL_MACHINE\Software\Spanlink\CAD\Site Setup exists 
and contains the entries specified in "Site Setup" on page 18.

■ Verify that the registry entries used by specific services exist and are valid. 
See "Registry Entries" on page 18.

Network Check

■ On the Agent Desktop services computer, verify that the IP address in the 
registry value HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\Site 
Setup\IOR HOSTNAME is the correct IP address of the public NIC.

■ To view information about the NICs on the computer, open a command 
window and type ipconfig /all.

■ Verify that the hostname and IP address are as expected.

■ Verify that the subnet mask is correct. It is probably 255.255.255.0.

■ If there are multiple NICs enabled, verify that the public NIC comes before the 
private NIC:

1. In the Control Panel, double-click Network and Dial-up Connections. 
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2. From the menu bar, choose Advanced > Advanced Settings.

3. On the Adapters and Bindings tab, verify that the NICs are in the correct 
order in the Connections pane. 

■ Check the network connectivity by pinging from the Agent Desktop services 
computer to others in the configuration, for example, the Unified CM 
computer. Then reverse it by pinging from the other computers to the Agent 
Desktop services computer. Do this using both hostnames and IP addresses 
and ensure that the ping results match.

■ If hostnames are used, verify that the appropriate DNS, WINS, and hosts files 
are correct.

■ If there is a problem connecting to a particular service, try typing telnet <IP 
address/hostname> <port> in a command window, where <IP 
address/hostname> is the IP address or host name of the computer where 
the service is running and <port> is the port used by the service. 

■ Use a network protocol analyzer like Ethereal (www.ethereal.com) to analyze 
network communications.

Memory Check

■ Ensure that the amount of memory on the computer is at least the minimum 
required for Agent Desktop and other installed software. If the amount of 
memory is below the recommended level, it could be the source of the 
problem.

■ Use Microsoft Perfmon (perfmon.exe) to perform most memory checking.

Add the following counters for _Total and process of interest:

■ Private Bytes

■ Virtual Bytes

■ Handle Count

■ Thread Count

If the values for those counters keep growing without leveling or decreasing, it 
is likely the process has a memory leak.

If the values for those counters for a process are a significant part of the 
total memory used, it may be of concern. Note that certain processes will 
normally use more memory than others.

■ Try rebooting the computer and see if it fixes the problem. Check how much 
and how fast processes increase their memory usage.
52 August 6, 2012

http://www.ethereal.com


Diagnostic Procedures
CPU Check

■ Ensure that the computer’s processor is at least the minimum required for 
Agent Desktop and other installed software. If the processor is below the 
recommended level, it could be the cause of the problem.

■ Use Task Manager to sort processes/applications by CPU usage. Check which 
process seems to be using the CPU most of the time.

■ Use Windows Perfmon (perfmon.exe) for additional CPU checking.

— Add the %Processor Time counter for Processor > _Total and each CPU as 
well as Process >_Total and process of interest.

— Check which process seems to be using the CPU most of the time.

— If the counter values for a process are a significant part of the total CPU 
use, it may be of concern. Short spikes are acceptable but a significant 
time with high CPU usage is of concern. 

■ Try rebooting the computer to see if it fixes the problem.

Blocked Ports Check

To check whether a port is blocked:

■ Using Telnet:

1. Ensure that the service is running and active. 

2. From the command line, type telnet <hostname/IP address> <port> and 
press Enter, where <hostname/IP address> is the hostname or IP 
address of the service computer and <port> is the port the service is 
listening on. 

3. If it is successful, the command window will clear with cursor at top left 
corner; you will need to close the window. 

4. If the Telnet fails, you will probably see a connection failure.

■ Check firewall settings on the client and server computers.

■ Check firewall logs.
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Problem Partial call history or partial data appears in the Enterprise Data fields 
for calls right after a failover.

Symptom. When an agent receives a call, the Enterprise Data pane 
and/or the Enterprise Call History pane does not display complete data 
for calls that began prior to or occurred during a failover.

Cause. The system might have active calls during failover. The 
Enterprise service tries to get call information for such calls by making a 
snapshot of the call. The snapshot does not provide complete call 
history, thus the missing data.

Solution This is expected behavior. A call that occurs when the Enterprise 
service is up and running after a failover will have complete data.

Problem The CPU usage on the agent’s PC has gone to 99%, and the PC has 
locked up. 

Solution This can happen when you disable the sniffing adapter through the 
Windows Network and Dialup Connections window while Agent Desktop 
is running and is being monitored and/or recorded by the supervisor or 
recorded by the agent, using Desktop Monitoring. Re-enabling the 
sniffer adapter while Agent Desktop is running will not solve the 
problem You must stop Agent Desktop, re-enable the sniffer adapter, 
and then restart Agent Desktop to restore normal functionality.

Problem An agent using Windows XP was able to start Agent Desktop, but was 
not able to enter an active state.

Solution Windows XP can be configured so that the Internet Connection Firewall 
(ICF) is active. ICF acts by keeping track of all traffic to and from the 
computer; it will only allow information through that has originated from 
that particular computer. If a message originates from outside the 
computer, it will be discarded. 
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To solve this problem, either turn off ICF (requires someone with 
administrator rights to the computer) or override the defaults to include 
known “good” connections like the CAD servers.

Problem The agent received the error message, “The agent- or workflow-initiated 
action request failed.” 

Solution This error message is displayed when a request to the Unified CCX 
engine, for example a call control action or agent state change, is 
rejected. Try the action again.

Problem The agent is unable to log in to Agent Desktop.

Symptom: An agent receives an error message when trying to log in to 
Agent Desktop. Possible error messages include the following:

■ Failed to log into CTI Manager Server! Please talk to your 
administrator.

■ The ID you entered was not found.

■ Unable to log agent in.

■ A critical error has been received. Either your phone or Unified CM 
is offline. If you are not already logged out, you may need to logout 
and try to log in again.

Cause. Depending upon the error message, the cause could be one of 
the following:

■ If the error message involves the CTI Manager Server, the problem 
might be that the Enable CTI Application Use is not configured for 
the agent user ID, the CTIManager service is not running on the 
Unified CM server, or you are using an invalid password.

■ If the ID you entered was not found, the ID could be invalid.

■ If the agent cannot log in, the agent’s phone might not be 
associated with the RmCm provider in Unified CM.

■ If you receive the critical error message, the Unified CM server 
might be offline or the agent’s IP phone has reset.

Solution Correct the problem related to the error message:

■ If the message relates to the CTI Manager server, make sure that 
the CTIManager service is running on the Unified CM server.
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■ If the ID was not found, make sure that you are typing the user ID 
correctly. User IDs are case sensitive. Verify that you are using the 
correct password configured for the agent in Unified CM.

■ If the agent's phone is not associated with the RmCm provider, 
access the Unified CM Administration application. Choose User 
Management > Application User, then select the RmCm provider. In 
the Device Information section on the Application User 
Configuration page, associate the agent's IP phone with the RmCm 
provider.

■ If you receive the critical error message, make sure that the 
Unified CM server is online, and verify that the agent’s phone is in 
service.

■ Unified CM is up and running, provided the Unified CCX setup is 
pointing to a cluster of Unified CM servers.

Problem No data appears in the Enterprise Data fields.

Symptom. When an agent receives a call, the Enterprise Data pane 
does not display the expected data.

Cause. The Unified CCX server is not correctly passing enterprise data 
from the Enterprise service to Agent Desktop. This situation can be a 
result of incorrect step configuration in the script or in the Enterprise 
Data Configuration section of Desktop Administrator. This situation can 
also be a result of an out-of-sync condition between the Enterprise Data 
subsystem and the Enterprise service.

Solution Complete the following steps:

1. Verify the step configuration in the script and in the Enterprise Data 
Configuration section in Desktop Administrator.

2. Stop and restart the Enterprise service.

3. If the problem persists, stop and restart the Unified CCX engine.

Problem E-mail Ready and Not Ready buttons are not available in the toolbar.

Solution Complete the following steps:

1. Verify that the Agent E-Mail feature is properly configured.
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2. In Application Administrator, verify that the agent belongs to a 
resource group that has at least one e-mail CSQ assigned to it.

Possible causes include the following:

■ The E-Mail feature is only available in the premium package.

■ The E-Mail feature has not been configured.

■ The agent does not belong to any e-mail CSQs.

Problem The agent does not receive an e-mail when the E-Mail Ready button is 
activated.

Solution Complete the following steps:

1. Check the Contact Service Queue Statistics real time display and 
verify that there are e-mails in the queue.

2. Verify that the e-mail server has been configured correctly and that 
the Agent E-Mail service can connect to the Exchange server.

Possible causes include the following:

■ There are no e-mails in any of the queues to which the agent 
belongs.

■ The E-Mail feature has not been configured properly.

Problem A “Partial Service” or “No Service” message displays in the Agent 
Desktop status bar.

Symptom. The agent sees a message in the Agent Desktop status bar.

Cause. Agent Desktop has detected that it is unable to communicate 
with a service (generally within three minutes of the service failure), 
and displays the “Partial Service” or “No Service” message to indicate 
some or all of the services have failed.

Solution Double-click on the message in the status bar to display the Server 
Status popup window. This window lists Agent Desktop features and 
indicates which features are affected by the service failure. When Agent 
Desktop detects that the failed service is again available (usually within 
one minute of the service recovery) the status bar displays “In Service” 
to indicate that the service has recovered.
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Problem Agent toggles between Ready and Reserved states.

Symptom. The agent toggles between the Ready state and the 
Reserved state.

Cause. This might happen if a dial plan exists that starts with the same 
digit that the agent’s Unified CCX extension starts with. If the total 
number of digits in the agent’s extension in such a situation is less than 
the total number of digits configured for the dial plan, this symptom 
might occur.

Solution Make sure that the following two things do not happen concurrently:

■ An agent’s Unified CCX extension starts with a digit for which a dial 
plan exists in Unified CM.

■ The total number of digits in the agent’s Unified CCX extension is 
less than the total number of digits configured for the dial plan.

Problem When agents start Agent Desktop, they see the following error: “A 
licensing error has occurred. Please try again in five minutes. If the 
problem persists, please see your log file or the System Administrator 
for details.”

Symptom. Telnet tests from the agent PC to the LRM service on the 
Agent Desktop server (port 65432) fail. The LRM service is running and 
agents are able to connect some of the time. Cisco Security Agent (CSA) 
is installed and running on the Agent Desktop server.

CSA log reports the following: “Event: Possible SYN Flood detected. 
Source addresses include 10.X.X.X. TCP ports, including port 59004, 
SYN Flood protection has been enabled.”

Cause. CSA is in SYN Flood detection mode. Agent PCs have the firewall 
enabled and are blocking packets, and CSA thinks the PC is 
non-responsive.

Solution Short-term solution: Restart CSA on the Agent Desktop servers. 

Long term solution options include: 

Option 1: Leave the systems as is. Risk: SYN Flood detection mode 
might become enabled, which can prevent agents from logging in. If not 
discovered immediately, the problem can persist until SYN F turns off by 
itself (approximately two hours). 
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Option 2: Turn off SYN Flood detection mode. Risk: Leaves the server 
open to SYN Flood.

Option 3: Turn off Agent PC firewall. Risk: Could leave agent PCs 
vulnerable to viruses. 

Recommendation: Option 2. SYN Flood is generally not effective against 
modern networks.

Problem Every time the agent hangs up the telephone, Agent Desktop 
disappears.

Solution In Normal mode, Agent Desktop automatically minimizes when there 
are no active calls. This behavior is configured in Desktop Administrator. 
To prevent the Agent Desktop window from minimizing, click 
Preferences and select either Always Open or Always on Top.

Problem The administrator has made changes in Desktop Administrator, but they 
are not showing up in Agent Desktop.

Solution Agent Desktop must be restarted in order for the changes to take effect.

Problem The agent has changed Agent Desktop’s window behavior (from the File 
menu), but when Agent Desktop is restarted, the setting has not been 
saved. 

Solution Changes made to local settings via Agent Desktop are only temporary 
overrides of the global settings. Permanent changes must be made via 
Desktop Administrator.

Problem Sometimes during a conference call, a conference member shows up 
as <Unavailable>.

Solution <Unavailable> represents a party outside the switch. The switch sends 
the trunk number of the external party to the desktop, where it has no 
meaning. Agent Desktop replaces the trunk number with 
<Unavailable>.
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Problem The agent sent the supervisor an emergency chat message but the 
supervisor never received it.

Solution Supervisors receive emergency chat messages only if they are 
monitoring the team to which the agent who sent the message belongs.

Problem While running Agent Desktop, the error message, “Macro file failed to 
open,” keeps appearing.

Solution Turn off any virus scanning applications on the desktop. Virus scanning 
applications attempt to intercept calls to open a file to do their own 
processing first. This might cause the file to be opened in such a way 
that restricts other applications from opening the file.

Problem The agent can’t view any skills statistics in Agent Desktop.

Solution If an agent is not assigned to a skill group, no skills statistics are 
available. 

Problem When the agent starts Agent Desktop, a call appearance is displayed 
showing that the agent is on a call, even though there is no active call 
on the agent’s phone.

Solution On startup, Agent Desktop asks the CTI server for a snapshot of any 
existing phone calls to display to the user. Occasionally the CTI server 
returns invalid data. To dismiss the invalid data, the agent must click 
Drop. If the call appearance persists, the agent might have to close 
Agent Desktop, pick up the phone receiver to get a dial tone, hang up, 
and then restart Agent Desktop.

Problem Sometimes after placing a call on hold, the agent is unable to retrieve 
the call. Once the call is hung up, the agent state still reflects On Hold. 
Exiting and restarting Agent Desktop doesn’t help. 

Solution A task in Unified CM administration is associating devices with JTAPI 
users. The peripheral gateway JTAPI user should be associated with 
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agent telephones. The IP IVR JTAPI user should be associated with the 
CTI ports corresponding to the virtual ports on the IP IVR. 

Each of these device categories is distinct. A device cannot belong to 
more than one category. Failure to assign a device to exactly one 
category can cause problems.

Problem Sometimes while talking on a call, the agent is unable to change the 
agent state to Not Ready. As a result the agent keeps receiving calls 
from the ACD, even after closing the application.

Solution A task in Unified CM administration is associating devices with JTAPI 
users. The peripheral gateway JTAPI user should be associated with 
agent telephones. The IP IVR JTAPI user should be associated with the 
CTI ports corresponding to the virtual ports on the IP IVR. 

Each of these device categories is distinct. A device cannot belong to 
more than one category. Failure to assign a device to exactly one 
category can cause problems. Ensure that the agent’s phone is 
associated with the peripheral gateway JTAPI user.

Problem The agent is using Desktop Agent with an IP soft phone (for instance, IP 
Communicator) on a computer with multiple network adapter cards. 
When the agent switches from using one NIC to the other to connect to 
the network, the agent cannot log in. (An example of this situation is 
running Agent Desktop with an IP soft phone on a laptop that can 
connect to the network using either an Ethernet or wireless 
connection.)

Solution Each NIC has its own MAC address. Unified CM must be able to 
associate a MAC address with an extension in order for Agent Desktop 
to function correctly. If the Unified CM knows about only one of the 
multiple NICs, only that one will work. If an agent is going to use a 
computer with multiple NICs, Unified CM must be configured to 
recognize each NIC’s MAC address.

Problem The agent is logged out unexpectedly.

Solution Possible reasons are:
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■ Another agent with the same ID or extension has logged in, causing 
the first agent to be logged out.

■ A supervisor has logged the agent out.

■ The telephony service has failed.

■ The network has failed.

Problem The agent can make and receive internal calls but gets errors when 
trying to make an external call.

Solution The dial string properties must be configured properly for outgoing calls. 
Some switches are set up to automatically dial a 9 to get an outside 
line, while others require you to dial a 9. The dial string must take into 
account how the switch is set up.

Problem The agent’s call control action does not work properly.

Solution Try performing the same action manually using the dial pad. Telephone 
numbers are formatted the same way when used in call control actions 
as they are when making calls manually. Make sure that the dial string 
is configured properly for outgoing calls.

Problem There are four actions assigned to an event, but only the first two run.

Solution When executing a set of actions, execution is halted if any of the actions 
fail. This is because some actions might depend on previous actions 
executing correctly. Find out why the third action is failing and correct it.

Problem The only phone book appearing on the dial pad dialog box is the recent 
call list.

Solution The administrator disabled the phone books.
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Problem Global phone books appear but there is no personal phone book.

Solution The administrator disabled personal phone books.

Problem When editing a phone book, the agent can’t add an entry after editing 
the first name, last name, or notes.

Solution The agent must enter a phone number before the Add button is 
enabled.

Problem The agent can edit the personal phone book, but not other phone 
books.

Solution The personal phone book is not shared by other agents. The other 
phone books are shared, and can be edited only by the administrator.

Problem The agent can’t find the Log Viewer executable.

Solution Log Viewer is part of Agent Desktop, not a separate executable, and can 
be accessed by choosing the option File—View Logs from the Agent 
Desktop menu bar.

Problem When opening the Log Viewer, <N/A> is displayed in the first row.

Solution If there is no data for the selected day, the first row of the log viewer is 
filled with <N/A>.

Problem The agent changed the viewing options but pressed cancel. Why 
weren’t the changes to the filters canceled?

Solution There is a Cancel button for each of the filter dialog boxes. Once a filter 
has been accepted, it is saved. The Cancel button on the options dialog 
box only cancels changes made to the columns.
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Problem The keystroke macros do not play back correctly on dropped events.

Solution If Agent Desktop is running in normal mode (maximized when a call is 
received, and minimized when there are no call appearances), 
keystroke macros might play back to the wrong window. When Agent 
Desktop minimizes after a call is dropped, it steals focus from the target 
keystroke macro window. To fix this, place a [Delay]<milliseconds> 
command at the beginning of the keystroke macro, where 
<milliseconds> is the desired length of delay. This allows time for Agent 
Desktop to minimize before playing back the keystroke macro. For 
example:

[DELAY] 1000
[APPLICATION:NOTEPAD=UNTITLED - NOTEPAD]

Problem Macros are not playing back correctly.

Solution When playing keystrokes to a window, Agent Desktop must first find the 
window. When recording the macro, Agent Desktop saves the window’s 
title and class name (an internal Windows variable associated with a 
window). On playback, Agent Desktop searches in this order:

1. Find a window with the saved title and class name.

2. Find a window with the saved class name.

3. Find a window with the saved title.

If Agent Desktop does not find a window matching one or more of these 
criteria, it displays an error message.

If there are two windows with the same name and class, Agent Desktop 
might play back the macro to the incorrect window.

If there are several windows with the same class name, and the title of 
the target window has changed, Agent Desktop might play back the 
macro to the incorrect window.

Some compilers/class libraries use the same class name for all 
windows. If you have developed an in-house application, you might 
need to change the class name in your application.
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Problem A keystroke macro will not play back even though the target application 
is running.

Solution Agent Desktop uses the application’s class name and title to find the 
target application. Some applications change title and class name 
when changing screens. If this happens, Agent Desktop might not be 
able to locate the target application. Try using just the window title or 
class name to find the target application.

Example 1: Find both the title (NOTEPAD) and class (UNTITLED - 
NOTEPAD).

[APPLICATION:NOTEPAD=UNTITLED - NOTEPAD]
[SHIFT] D
et cetera.

Example 2: Find just the class (NOTEPAD):

[APPLICATION:NOTEPAD=]
[SHIFT] D
et cetera.

Example 3: Find just the title (UNTITLED - NOTEPAD):

[APPLICATION:=UNTITLED - NOTEPAD]
[SHIFT] D
et cetera.

Problem The administrator created a macro and put in some delays. Now the PC 
appears to lock up while the macro runs.

Solution When a macro runs, the operating system takes over the PC and locks 
out all user input. This is a characteristic of the operating system. Try to 
minimize the length of time your macro runs.

Problem A keystroke macro plays the wrong keys to the wrong window.

Solution Make sure macro playback starts from the same place every time it 
runs. Have the macro start from the same starting window with the 
cursor in the same starting position as when the macro was recorded.
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Problem When a macro is played back, it seems to be missing keystrokes, or the 
PC locks up.

Solution Due to the wide variety of systems and configurations, macro playback 
speed can vary. To slow down the rate at which a macro plays back 
keystrokes, add this section to the fastcalllocal.ini file:

[MacrosMisc]
DelayTime= <n milliseconds>

where n milliseconds is some value in milliseconds to delay between 
each macro event.

Problem After a macro runs, focus remains on the application to which it played. 
How can the macro be written to make it change focus to Agent Desktop 
(or some other application)?

Solution To change focus to Agent Desktop, edit the macro and insert this line at 
the end:

[APPLICATION:AGENT_DESKTOP=AGENT_DESKTOP]

You can also change focus to an application other than Agent Desktop. 
To determine the line to insert, create a dummy macro and play a few 
keystrokes to the application. When you finish recording, cut and paste 
the application’s text identifier from the dummy macro to the macro you 
wish to edit.

Problem Sometimes when a macro is running, the PC appears to lock up for 
short periods of time.

Solution A [DELAY] statement in a macro causes the system user-input hook to 
keep control of the system. The PC runs but rejects all user input until 
the macro finishes playing. To limit this problem, use the shortest 
delays possible.
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Problem The agent pressed Ctrl+Alt+Del while a macro was running, and now 
the Agent Desktop window is locked up.

Solution You cannot click Start or press Ctrl+Break, Ctrl+Esc, or Ctrl+Alt+Del 
when recording a macro. The Windows operating system unhooks the 
system keyboard hook when Start is pressed. 

Problem The agent is participating in a blind conference call, but cannot see all 
parties on the call.

Solution In Agent Desktop 7.0, a blind conference is defined as adding an 
alerting party to a conference. All parties on a blind conference call 
might not show up in either Supervisor Desktop or Agent Desktop. This 
is a limitation of the CTI server software.

Problem Increasing the font size in Agent desktop causes information in the 
status bar, including agent name and extension, to be truncated.

Solution After increasing the font size, you must restart Agent Desktop to display 
all of the information in the status bar without truncation.

Problem When trying to view agent state or call logs, no data is presented.

Solution The agent may not have received a call, or logged in for that particular 
day. The agent’s or supervisor’s PC clock may not be in the correct time 
zone.

NOTE:  All state and call times are based on server time.

Problem After an upgrade, the Report Font Size field is blank on the Accessibility 
Options tab of the Desktop Preferences dialog box in Agent Desktop.

Solution Select a font size from the drop-down list. The minimum report font size 
is 15. 
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Problem An agent’s screen reader is not reading the contents of table cells in 
agent reports.

Solution Text in reports might not be readable initially by screen readers. Consult 
your screen reader’s documentation for information on forcing the 
program to read text in report cells.

Problem After upgrading CAD from CAD 6.4(1) to CAD 6.6, agents do not see 
their global and/or personal phone books. The phone books were 
available before the upgrade.

Solution The phone books must be enabled in Cisco Desktop Administrator. 

1. In Desktop Administrator, select Call Center 1 > Work Flow 
Configuration > Phone Book.

2. Ensure that the appropriate phone books (global and/or personal) 
are selected, and then click Apply.

Problem An administrator cannot telnet from the Unified CCX server to a desktop 
hosting a CAD application.

Solution Any firewall between the Unified CCX server and the desktop must have 
ports 59000–59030 open so that access to the desktop is allowed.

Problem Cisco Agent Desktop login times out when an agent attempts to log in. 
There is Active Directory (AD) redundancy, and the primary AD is down.

Solution Modify the configuration file PhoneDev.cfg on the agent desktop by 
adding a longer timeout time.

1. On the agent desktop, navigate to C:\Program 
Files\Cisco\Desktop\config.

2. Open PhoneDev.cfg in a text editor.

3. Add the following entry:

[ReqTimeout] Milliseconds=30000

4. Save the file.
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Agent E-Mail Problems

Problem Cannot connect to IMAP or SMTP.

Solution The most likely cause for this problem is incorrect information entered 
for e-mail address or login/password. Use Outlook or telnet to check the 
connection. For more information, see "E-Mail Connectivity Check" on 
page 48. 

Problem Cannot send e-mail or e-mails take a long time to send.

Solution After checking basic connectivity to the SMTP server using telnet, check 
to see if your virus checker, firewall, or other security software is 
interfering with the message. SMTP is a very common protocol for 
malware to use, and as a result virus checkers are very suspicious 
about programs that use it. Try turning virus checker, firewall, and other 
security software off momentarily to diagnose the problem.

Problem E-mails are not routed to my agents.

Solution In order for e-mails to be routed to agents you must create e-mail 
distribution lists for each incoming address, and each of these 
addresses must be mapped via administration to a CSQ that has been 
configured for the Agent E-Mail feature. Note that Exchange 2007 
rewrites incoming e-mail "to:" addresses which is the reason 
distribution lists must be used, rather than aliases.

Problem The E-mail Ready or E-mail Not Ready buttons are seen on my desktop.

Solution The E-Mail feature will only enable if the agent is licensed as premium 
and the agent belongs to at least one CSQ that is designated as an 
e-mail CSQ.  Check to make sure you are licensed for premium and that 
the agent belongs to at least one e-mail CSQ.
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Problem I'm sure my login is correct, but I still can't get logged in to IMAP, even 
though it works in Outlook.

Solution If outlook works, but Telnet does not, it is probably because the account 
you are using to log in is an NT domain account. When logging into IMAP 
you need to specify the login as follows:  

NTDOMAIN/NTACCOUNT/ALIAS 

For example, if your e-mail address is "Jane.Doe@myserver.com", your 
Windows NT login name is "jdoe", your NT domain name is "mydomain", 
and your Exchange mailbox name is "Jane Doe", you would then need to 
use a username of "mydomain/jdoe/Jane.Doe" when logging in.

Problem I finally got logged into IMAP, but now SMTP doesn't work.

Solution SMTP logins are not as complicated as IMAP logins. Use your account 
name; as in the previous example, use "jdoe."

Problem Some attachments don't make it through.

Solution Your e-mail server may limit messages to a certain maximum size.  In 
addition, the server or a virus checker may filter certain attachment 
types that can contain malware.

Problem It looks like I'm sending my e-mails out, but they did not arrive at the 
destination address.

Solution The recipient’s mailbox may reject the e-mail, because the message is 
too large, or their mailbox is full, or they have attachment restrictions.  
Typically in this situation, the recipient SMTP server will send a delivery 
status message back to the sender. The Agent E-Mail service will detect 
this type of message, write a message to its log file and move the 
message to the System Status folder on the mail store. You can 
manually inspect this folder using Outlook, as described earlier, and 
associate the delivery status message with the sent and handled 
messages store in their respective folders. If you wish to requeue the 
handled message so that an agent can respond to it again, drag that 
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message back to the inbox. Another alternative is to open the sent 
message and attempt to resend it manually if you suspect that the 
recipient will now be able to accept it. You would also be able to remove 
attachments before resending them if the reason for the failure was 
due to the attachments.

Problem An agent has draft e-mails but is not in the office, how can I requeue 
the e-mails so another agent can handle them?

Solution You can requeue the e-mails by logging in as that agent using the CAD 
desktop.

Problem A corrupt or malformed e-mail is in the inbox and I would like to remove 
it because it cannot be routed to or read by agents.

Solution Log in to Outlook as the other agent and manually delete the e-mail 
from the inbox.

Problem A supervisor cannot use a supervisor workflow action to send an e-mail. 
However, when the e-mail client is configured with the supervisor’s 
credentials, the supervisor can send an e-mail directly. The supervisor 
log files do not contain any error messages.

Solution Some virus checkers might prevent e-mails from being sent. Disable all 
virus checkers on the supervisor’s PC. 

Problem Although there are many e-mails in the server mailbox, the Agent E-Mail 
service is not pulling any e-mails from the mailstore.

Symptom: The Agent E-Mail server could not connect to the Exchange 
Server via SMTP port 25.

Solution McAfee VirusScan 8.0 prevents sending mass mailing, thereby blocking 
telnet to port 25. To overcome this problem with McAfee VirusScan 8.0, 
follow these steps.

1. Start the VirusScan Console. 
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2. Select Access Protection Properties. 

3. Under Ports to block, clear the Rule against Port 25 that says 
“Prevent mass mailing worms from sending mail.” You will then be 
able to telnet to the mail server on port 25.

Problem Agent has no e-mail buttons.

Solution Verify the following:

■ The contact center is using premium licenses.

■ The agent services at least one e-mail CSQ.

■ The integrated browser is enabled for the agent’s workflow group.

■ In workflow administrator, the e-mail buttons are visible for the 
agent’s workflow group.

If any changes needed to be made, restart the agent desktop.

Problem The agent is not receiving any e-mail.

Solution Check if the Agent E-mail account is locked out in Active Directory.

Problem When an agent selects an e-mail in the Contact Appearance pane, the 
error message, “An error has occurred” is displayed. The Unified CCX 
server is able to ping the Exchange server with its host name, but client 
desktops cannot. 

Solution If host names are being used for the mail store, ensure that client 
desktops can resolve that host name. If not, use the IP address instead.

Problem Agent e-mail responses are not sent back to customers.

Microsoft Exchange has not been configured to allow the Cisco Agent 
Desktop SMTP user permission to send from the e-mail address 
specified in Cisco Desktop Administrator.
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If this is the case, the EEMServerJavaXXXX.dbg log will show an error 
similar to the following while trying process messages in the outbox:

2008-10-06 13:06:30,334 DEBUG 
[OutboxThread|Outbox#processOutbox:69] e.getMessage: 550 
5.7.1 Client does not have permissions to send as this sender

The message is then moved to the Not Sendable folder on the mail 
store.

Solution To correct this problem, do the following (applicable to 
MS Exchange 2007):

1. Start the Exchange Management Shell.

2. At the prompt, execute the command:

Add-ADPermission -Identity <distributionListId> -User 
<cadUserId> -AccessRights extendedright -ExtendedRights 
"send as"

Where <distribution list ID> is the distribution list identifier and 
<CAD user ID> is the user ID of the mailbox that CAD has been 
configured to use.

3. Repeat step 2 for every distribution list that you want CAD to be 
able to use to respond.

4. Close the Exchange Management Shell.

5. Restart the Agent E-mail service for the Exchange settings to take 
effect.

6. Use a third party IMAP client to move messages from the Not 
Routable folder back to the Outbox so that the Agent E-mail Service 
can attempt to process them again.

Problem An agent logged into CAD behind VPN is logged out after a failover. After 
the system fails back, the agent is unable to access the Agent E-Mail 
feature. 

Solution This issue occurs when nodemanager failover occurs while Agent 
Desktop is in the process of downloading the applet. The applet is not 
completely downloaded when the failover happens, therefore the applet 
is not running and no failover occurs.
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Problem CAD (with Microsoft Exchange 2007) is configured to route e-mails sent 
to sales@example.com to CSQ 1. A customer puts that address in the 
BCC field of an e-mail message and nothing in the To or CC fields. The 
e-mail is delivered to the contact center but ends up in the Not Routable 
folder.

Solution Exchange 2007 is designed to remove the e-mail addresses from the 
BCC field. As a result, CAD cannot route the incoming e-mail to the 
appropriate CSQ and instead sends the e-mail to the Not Routable 
folder. The e-mail address in the BCC field cannot be recovered, and any 
e-mail using only the BCC field for the recipient e-mail will be routed to 
the Not Routable folder.

Problem Agent E-Mail message routing performance is degraded and/or the logs 
show signs of connectivity issues.

Symptom. The following is present in the Event Viewer logs in the 
Exchange Management System:

■ Event ID: 9646

■ Type: Error

■ Source: MSExchangeIS

■ Description: Closing Mapi session 
“/o=Organization/ou=Administrative 
Group/cn=Recipients/cn=user” because it exceeded the maximum 
of 250 objects of type “objMessage”.

Cause. By default, MS Exchange limits the number of messages sent 
per MAPI session to 250 and the number of attachments sent to 100. 
In contact centers with a large number of agents using Agent E-Mail 
these limits might be exceeded, which might result in messages not 
being sent. 

Solution Complete the following steps:

1. Ensure that MS Exchange is configured according to the “Message 
Throttling Policies in MS Exchange” section of the Cisco CAD 
Installation Guide before proceeding. Message routing 
performance is degraded if the MS Exchange server is not 
configured according to these settings.

2. Verify the expected routing times according to the “Agent E-Mail 
Routing Expectations” section of the Cisco CAD Installation Guide. 
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Message routing performance should be within these specified 
parameters.

If you are still experiencing delays, modify the registry (applies to 
MS Exchange 2003 and 2007). 

There are 13 MAPI-related constraints that might cause the above 
Event Viewer error. The Event Viewer message will specify which 
constraint is being exceeded.

Refer to the following article by Microsoft Support (Article ID: 830829) 
for more information about these MAPI-related settings and associated 
remedial steps:

http://support.microsoft.com/?kbid=830829

Symptom. On the MS Exchange server, the performance counter 
“MSExchangeIS\RPC Client Backoff/sec” indicates back-off requests 
are being sent to clients.

Cause. If the combined operations of the MS Exchange user account 
devoted to Agent E-Mail exceed the default RPC operations per second 
limitation, the MS Exchange server sends back-off requests to Agent 
E-Mail. Agent E-Mail does not conform with these back-off requests 
(and, even if it did, it would not improve message routing performance). 
By not conforming with these requests, MS Exchange temporarily 
suspends communication with the offending clients. This in turn 
degrades message routing performance.

Solution Because one MS Exchange user is used for all Agent E-Mail operations, 
you can avoid exceeding the default RPC operations per second 
limitation by disabling RPC Client Throttling altogether.

Perform the following steps to disable RPC Client Throttling:

1. On the MS Exchange Server, start the Registry Editor.

2. In the Registry Editor window, select HKEY_LOCAL_MACHINE > 
SYSTEM > CurrentControlSet > Services > MSExchangeIS > 
ParametersSystem.

3. From the Edit menu, choose New > DWORD Value.

4. Enter RPC Throttling Factor as the entry name, and then press Enter 
again to display the Edit DWORD Value window.

5. In the Value data field, change the value to 0, and then click OK.

6. Close the Registry Editor window. 

7. From the Start menu, select Run.
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8. In the Open field, enter services.msc, and then click OK.

9. Select the Microsoft Exchange Information Store service, and then 
select Restart Service.

For more information, refer to Understanding Client Throttling at:

http://technet.microsoft.com/en-us/library/cc540454%28v=exchg.80
%29.aspx

Solution If neither of the solutions above resolve this issue, try completely 
disabling all MAPI session limits. To do so, perform the following steps:

1. Select the Start menu, then select Run.

2. In the Open field, enter regedit, and then click OK.

3. Select HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > 
Services > MSExchangeIS > ParametersSystem.

4. If the Disable Session Limit setting does not exist, do the following:

5. Choose the Edit menu > New > DWORD Value.

6. Enter Disable Session Limit as the entry name.

7. Right-click Disable Session Limit and then select Modify from the 
popup menu.

8. Click Decimal, enter 0 (zero) in the Value data box, and then click 
OK.

9. Exit the Registry Editor.

10. Select the Start menu, then select Run.

11. In the Open field, enter services.msc, and then click OK.

12. Select the Microsoft Exchange Information Store service, and then 
select Restart Service.
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Backup and Restore Problems

Problem BARS fails to back up files.

Solution Symptoms indicate that a client or server can’t connect to LDAP on Side 
B. To correct this problem, restart Side B. If this does not fix the issue, 
restart both Side A and Side B.

Problem In the process of upgrading from CAD 7.x to CAD 8.0 (Windows to Linux), 
the BARSCli backup fails. 

Solution BARSCli fails when Java is configured to use a proxy server to connect to 
the Internet. To disable this setting, follow these steps.

1. In Control Panel, open the Java Control Panel.

2. On the General tab, click Network Settings.

3. Select the Direct connection option and click OK.
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CAD-BE Problems

Problem The browser returns HTTP Status 404 after entering the CAD-BE URL.

Solution An incorrect URL for CAD-BE was used. Make sure the correct URL is 
used. The URL is case-sensitive. The correct URL is the following, where 
<Unified CCX server> is the IP address for the server that hosts Cisco 
Unified CCX.

http://<Unified CCX server>:6293/cadbe/CAD-BE.jsp

Problem The browser returns the error “The page cannot be displayed.”

Solution The browser cannot communicate with the Tomcat service. 

■ Make sure the IP address or hostname is for a valid CAD server.

■ Make sure the port is 6293. The port to use is specified in 
<Parameter name=”port” value=”6293”/>, under the section 
<!-- Normal HTTP --> in C:\Program Files\wfavvid\tomcat_
appadmin\conf\server.MADM.xml.

■ Check in Unified CCX Admin Control Center whether Cisco Unified 
CCX Administration on the BIPPA server is running.

■ Make sure port 6293 is not blocked from the client or server 
computer. 

Problem A popup message indicates that CAD-BE is unable to connect to the 
BIPPA service. The CAD-BE log also shows “CADBE1002: Could not 
connect to BIPPA service.”

Solution The BIPPA service might be down or is not active.

■ If this is a redundant system, the URL used may be pointing to the 
standby BIPPA service. Use the active BIPPA service. 

■ Start the BIPPA service if it is down.

■ Check the CAD Configuration Setup utility on the BIPPA server to 
see if the externally visible names or IP addresses specified for the 
CAD-BE servers are correct. They must be the same as the ones 
used in the CAD-BE URL. If changes are made to the settings in CAD 
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Configuration Setup, the BIPPA service(s) must be restarted for the 
changes to take effect. 

■ Make sure port 59012 is not blocked from the client or server 
computer. 

■ On a nonredundant system, if the LRM service is down, then the 
BIPPA service will become standby. Restart the LRM service.

■ Desktop Administrator, Agent Desktop, or Supervisor Desktop was 
installed on the same computer as the CAD services. They clear a 
registry key (IOR Hostname under Site Setup) required by the BIPPA 
service. Set the registry to the public IP address of the CAD services 
computer.

■ CAD-BE was running when the CAD server computer was upgraded. 
As a result, CAD-BE is a different version than the BIPPA service to 
which it was attempting to connect.

■ CAD-BE timed out while attempting to reach the BIPPA service. 
Check the BIPPA server to make sure its CPU is not too high. Check 
that network latency between the desktop and BIPPA server 
computers is not too high.

Problem When starting up CAD-BE, the JRE plug-in installation begins.

Solution The agent is running CAD-BE on a computer on which the JRE plug-in is 
not installed. Once the plug-in is installed, this will not happen again. 
Allow the JRE plug-in installation to complete, after which CAD-BE will 
start normally.

Problem When starting up CAD-BE, the browser displays the following message: 
“This site might require the following ActiveX control ‘J2SE Runtime 
Environment 5.0 Update 11’ from ‘Sun Microsystems, Inc.’. Click here to 
install if you do not have the required Java Runtime Environment 
version installed.”

Solution The agent is running CAD-BE on a computer on which the JRE plug-in is 
not installed. The browser security settings prevent the browser from 
automatically installing the JRE plug-in. See the Cisco CAD Installation 
Guide for the correct Internet Explorer and Firefox settings. After you 
correct the settings, restart CAD-BE.
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Problem When starting up CAD-BE, the browser displays the following message: 
“Your security settings do not allow Web sites to use ActiveX controls 
installed on your computer. This page may not display correctly. Click 
here for options if you have Java or ActiveX controls disabled in your 
browser.”

Solution The agent is running CAD-BE on a computer on which the security 
settings prevent the browser from running ActiveX components. This 
will prevent the JRE plug-in from running. The JRE plug-in is required to 
run CAD-BE. See the Cisco CAD Installation Guide for the correct 
Internet Explorer and Firefox settings. After you correct the settings, 
restart CAD-BE.

Problem When starting CAD-BE, the browser displays the following message: 
message: “JavaScript is disabled in your browser. CAD-BE requires 
JavaScript to function properly. Configure your browser so that 
JavaScript is enabled, or contact your administrator for assistance.”

Solution Javascript is not enabled in the browser. See the Cisco CAD Installation 
Guide for the correct browser settings. After you correct the settings, 
restart CAD-BE.

Problem When starting CAD-BE, the browser displays the following message: 
“Your browser does not understand the object tag. CAD-BE will not run.”

Solution This message appears in the following circumstances: 

■ You are using an unsupported browser. Internet Explorer 6 and 7 
and Mozilla Firefox 1.5 and above are the only supported browsers 
for this release.

■ You do not have the required version of the JRE plug-in installed. 
CAD-BE will display messages pointing you to a valid location from 
which to install the correct version of JRE.

■ You have ActiveX controls disabled in your browser. See the Cisco 
CAD Installation Guide for the correct browser settings. After you 
correct the settings, restart CAD-BE.

■ You do not have Java enabled. See the Cisco CAD Installation Guide 
for the correct browser settings. After you correct the settings, 
restart CAD-BE.
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Problem When starting CAD-BE, the browser displays a message that pop-ups 
are blocked.

Solution The browser is configured to block pop-ups. Disable any third-party 
popup blockers. Refer to the Cisco CAD Installation Guide for the 
correct browser settings. If CAD-BE is still being blocked by pop-up 
blockers, hold down the Ctrl key when selecting the CAD-BE URL to 
temporarily unblock pop-ups.

Problem When starting CAD-BE, the CAD-BE window is closed. Another CAD-BE 
window is displayed, and no login dialog is displayed. 

Solution CAD-BE is already running on the desktop, and the agent tried to start 
another instance of CAD-BE. Only one instance of CAD-BE can run on a 
desktop. Do not start more than one instance.

Problem When starting CAD-BE, an empty browser window is left behind the 
CAD-BE window.

Solution Scripts cannot close windows. You can safely close this window 
yourself. Refer to the Cisco CAD Installation Guide for the correct 
browser settings to prevent the empty window from appearing.

Problem The agent is unable to log in. After the agent clicks OK on the Login 
dialog box, an error message appears that indicates one likely cause. 
The CAD-BE log file lists the message “CADBE3003: Unable to login 
agent. Cause <error code:error description>.”

Solution If the error message is “Invalid agent ID/name and/or password”:

■ The wrong agent ID/name and/or password was entered. Try 
logging in again. If the error message appears again, reenter the 
agent password in Unified CCX Administration. 

■ The agent is configured correctly in Unified CCX, but the Sync 
service has not synchronized the CAD LDAP database with 
Unified CCX. Verify that the Sync service is running. In Desktop 
Administrator, manually synchronize Directory Services, then verify 
that the agent exists under the Personnel node.
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■ In Unified CCX, verify that the Enable CTI Application Use check box 
is selected for the agent user ID.

If the error message is “Invalid phone configuration”:

■ Wrong phone extension was entered. Try again and enter the 
correct information.

■ Make sure the phone is associated with the Unified CCX agent and 
the agent’s phone is associated with the RmCm provider in 
Unified CM.

■ Phone is not pointing to the correct Unified CM server.

■ Verify that the Unified CM server is online and that the agent’s 
phone is in service and points to the same Unified CM (or 
Unified CM cluster) as Unified CCX.

If the error message is “No team found for agent”:

■ Agent does not belong to a team in Unified CCX. Associate the 
agent with a team in Unified CCX.

■ The agent was configured correctly in Unified CCX but the Sync 
service has not synchronized the CAD LDAP database with 
Unified CCX. Verify that the Sync service is running. In Desktop 
Administrator, verify that the agent exists and belongs to the 
correct team.

If the error message is “CTI service is offline”:

■ Make sure the CTI service is running and active again.

If the error message is “Invalid state change”:

■ The agent is attempting to change to Ready state after logging in 
while there was an active call. Drop the call and try again.

If the error message is “CTI request timeout”:

■ The network may be slow.

If the error message is “LRM service is down”:

■ Start the LRM service if it is down.

■ Agent Desktop or Supervisor Desktop was installed on the same 
computer as the CAD services. They clear a registry key (IOR 
Hostname under Site Setup) required by the BIPPA service. Set 
the registry to the IP address of the CAD services computer.

If the error message is “No more licenses”:
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■ Wait a few minutes and retry.

■ One or more CAD-BE agents might have exited their browsers 
without logging out first. Those sessions will continue to use up 
licenses for one minute after the browser exits.

■ One or more agents logged out of extension mobility without 
logging out from Agent Desktop, CAD-BE or IP Phone Agent. These 
agents are still logged in but in Not Ready state. Agent Desktop 
will continue to use the licenses until the application exits. 
IP Phone Agent will continue to use the licenses until the BIPPA 
service is restarted or until the agents login again and logout 
properly. CAD-BE will continue to use the licenses until the agents 
log out or one minute after CAD-BE is closed.

If the error message is “Forced login failed”:

■ The agent is using an agent ID that is already logged in on 
another extension, or using an extension that is already logged in 
with a different agent ID. Forced logins work only for the same 
ID/extension pair. Use a different agent ID or extension, or find 
the other user and have that user log out.

Problem The agent is logged in and in a ready state, and the computer’s screen 
saver or power saver feature has activated. CAD-BE is frozen or 
disconnected from the server.

Solution This is caused by a Java bug involving memory leaks. To avoid the 
problem, disable the screen saver/power saver features.

Problem A CAD-BE agent cannot be monitored or recorded.

Solution The CAD-BE agent’s phone is not set up for SPAN port monitoring.

Problem The Firefox browser freezes when agent attempts to make a call by 
clicking Make Call.

Solution The agent is running CAD-BE on a computer that has an unsupported 
version of the JRE plug-in installed. Check if the version of the plug-in 
that is installed is compatible with CAD-BE.
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Problem Agent Desktop closes unexpectedly when agent is using the integrated 
browser.

Solution This error might be caused by an external web application running in 
the integrated browser that has issued a close command that not only 
closes the browser but also closes Agent Desktop itself. The web 
application must be rewritten so that it only closes the browser window 
instead of the whole application.

Problem The agent is using CAD-BE with an IP soft phone (for instance, 
IP Communicator) on a computer with multiple network adapter cards. 
When the agent switches from using one NIC to the other to connect to 
the network, the agent cannot log in. (An example of this situation is 
running CAD-BE with an IP soft phone on a laptop that can connect to 
the network using either an Ethernet or wireless connection.

Solution Each NIC has its own MAC address. Unified CM must be able to 
associate a MAC address with an extension in order for CAD-BE to 
function correctly. If the Unified CM knows about only one of the 
multiple NICs, only that one will work. If an agent is going to use a 
computer with multiple NICs, Unified CM must be configured to 
recognize each NIC’s MAC address.

Problem The agent is logged out unexpectedly.

Solution Possible reasons include:

■ Another agent with the same ID or extension has logged in, causing 
the first agent to be logged out.

■ A supervisor has logged the agent out.

■ The telephony service has failed.

■ The network has failed.
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Problem The agent is participating in a blind conference call, but cannot see all 
parties on the call.

Solution In CAD-BE 6.6, a blind conference is defined as adding an alerting party 
to a conference. All parties on a blind conference call might not show up 
in either Supervisor Desktop, Agent Desktop, or CAD-BE. This is a 
limitation of the CTI service software.

Problem When an agent recieves a transferred call, the enterprise data is not 
correct.

Solution Call waiting is not supported in CAD. If call waiting is enabled, 
enterprise data might not be correct in certain circumstances. For 
example, if an agent is on a call and a new call is routed to that agent, 
and then that agent transfers the original call to another agent, the 
second agent’s desktop might display enterprise data for the new call, 
rather than the original call.

Problem The enterprise data portion of the Contact Management pane in 
CAD-BE is completely blank and does not display any information about 
the current call.

Solution This error can occur if an Agent Desktop agent edits the layout name 
during a call and enters the name of a layout that does not exist, and 
then transfers the call to a CAD-BE agent. In this situation, the 
enterprise data portion of the Contact Management pane in CAD-BE will 
be empty.

Problem Sometimes while talking on a call, the agent is unable to change the 
agent state to Not Ready. As a result, the agent keeps receiving calls 
from the ACD, even after closing the application.

Solution A task in Unified CM administration is associating devices with RmCm 
users. The peripheral gateway RmCm user should be associated with 
the agent telephones. The IP IVR JTAPI user should be associated with 
the CTI ports corresponding to the virtual ports on the IP IVR. Each of 
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these device categories is distinct. A device cannot belong to more than 
one category. Failure to assign a device to exactly one category can 
cause problems. 

Problem A “Partial Service” or “No Service” message displays in the CAD-BE 
status bar.

CAD-BE has detected that it is unable to communicate with a service 
(generally within three minutes of the service failure), and displays the 
“Partial Service” or “No Service” message to indicate some or all of the 
services have failed.

Solution Double-click on the message in the status bar to display the Server 
Status pop-up window. This window lists CAD-BE features and indicates 
which features are affected by the service failure. When CAD-BE detects 
that the failed service is again available (usually within one minute of 
the service recovery) the status bar displays “In Service” to indicate 
that the service has recovered.

Problem Sometimes after placing a call on hold, the agent is unable to retrieve 
the call. Once the call is hung up, the agent state still reflects On Hold. 
Logging out and restarting CAD-BE doesn’t help.

Solution A task in Unified CM administration is associating devices with RmCm 
users. The peripheral gateway RmCm user should be associated with 
agent telephones. The IP IVR JTAPI user should be associated with the 
CTI ports corresponding to the virtual ports on the IP IVR. Each of these 
device categories is distinct. A device cannot belong to more than one 
category. Failure to assign a device to exactly one category can cause 
problems.

Problem Partial call history or partial data appears in the Enterprise Data fields 
for calls immediately after a failover. 

Symptom. When an agent receives a call, the Enterprise Data pane 
and/or the Enterprise Call History pane does not display complete data 
for calls that began prior to or during a failover. 

Cause. The system might have active calls during failover. The 
Enterprise service tries to get call information for such calls by making a 
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snapshot of the call. The snapshot does not provide complete call 
history, thus the missing data. 

Solution This is expected behavior. A call that occurs when the Enterprise service 
is up and running after a failover will have complete data. 

Problem No data appears in the Enterprise Data fields.

Symptom. When an agent receives a call, the Enterprise Data pane 
does not display the expected data.

Cause. The Unified CCX server is not correctly passing enterprise data 
from the Enterprise service to BIPPA service. This situation can be a 
result of incorrect step configuration in the script or in the Enterprise 
Data Configuration section of Desktop Administrator. This situation can 
also be a result of an out-of-sync condition between the Enterprise Data 
subsystem and the Enterprise service.

Solution Complete the following steps:

1. Verify the step configuration in the script and in the Enterprise Data 
Configuration section in Desktop Administrator.

2. Stop and restart the Enterprise service.

3. 3. If the problem persists, stop and restart the Unified CCX engine.

Problem The administrator has made changes in Desktop Administrator, but the 
changes are not showing up in CAD-BE.

Solution The CAD-BE agent must log out and restart the browser in order for the 
changes to take effect.

Problem When the agent starts CAD-BE, a call appearance is displayed showing 
that the agent is on a call, even though there is no active call on the agent’s 
phone.

Solution On startup, CAD-BE asks the CTI service for a snapshot of any existing 
phone calls to display to the user. Occasionally the CTI service returns 
invalid data. To dismiss the invalid data, the agent must click Drop. If the 
call appearance persists, the agent might have to log out and close the 
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CAD-BE browser, pick up the phone receiver to get a dial tone, hang up, 
and then restart CAD-BE.

Problem The agent sent the supervisor an emergency chat message but the 
supervisor never received it.

Solution Supervisors receive emergency chat messages only if they are 
monitoring the team to which the agent who sent the message belongs.

Problem Sometimes during a conference call, a conference member shows up 
as <Unavailable>.

Solution <Unavailable> represents a party outside the switch. The switch sends 
the trunk number of the external party to the desktop, where it has no 
meaning. CAD-BE replaces the trunk number with <Unavailable>.

Problem When starting CAD-BE, the browser displays the message “The version 
of JRE installed on your PC is higher than the maximum version 
supported by CAD-BE. Uninstall all instances of JRE that have a version 
higher than the maximum version supported by CAD-BE, then install the 
version of JRE that is supplied with CAD-BE.”

Solution If using Firefox, uninstall any JRE higher than 1.5 or switch to using 
Internet Explorer. Make sure a supported JRE 1.5 is installed.

Problem CAD-BE displays the following error on launching: “You do not have the 
required version of the JRE plug-in installed.You can install the JRE 
plug-in from the CAD Installation webpage.”

Solution Uninstall the current JRE version installed on the client PC and launch 
CAD-BE again. It will take you to the Unified CCX web page from where 
you can download  a compatible JRE version.
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Problem How can I tell if a CAD service is running? 

Solution To view the status of all the services in the CAD system, log into the 
Unified CCX Administration application. Choose System > Control 
Center. Then select the server where the CAD services are located.

CAD services are now visible on the right panel. You can view their 
running status, and whether they are in an active (M) or standby (S) 
state.

Problem How can I check if the Unified CCX services are running?

Solution Log into the Unified CCX Administration application. Choose System > 
Control Center. Then select the server where Unified CCX services are 
located.

Unified CCX services are now visible on the right panel. You can view 
their running status, and whether they are in an active (M) or standby 
(S) state.

Problem The message, “At least one or more errors occurred during 
synchronization” appeared when the administrator performed 
synchronization in Desktop Administrator. 

Solution Check the Sync service log file. 

■ If the logged error points to a problem with the ACMI connection, 
look for problems with the CTI Server. Also look for similar problems 
in the Enterprise Server logs.

■ If the logged error points to an LDAP error, make sure the LDAP 
service is running and the LDAP Host 1 registry setting in the 
following entry has the correct value:

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\Site Setup
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Problem How can I tell if the Tomcat webserver is installed correctly?

Solution Perform the following tests:

■ Log into Unified CCX Administration. Choose System > Control 
Center. Then select the server where Unified CCX services are 
located. Verify that the Unified CCX Administration is running.

■ On the PC where the BIPPA service is installed, check the Services 
Control Panel to see if the BIPPA service is running. 

■ Type the following URL in the address field of your web browser, 
where <Tomcat> is the IP address of the server on which Tomcat is 
installed.

http://<Tomcat>:6293/ipphone/jsp/sciphonexml/
IPAgentInitial.jsp

If these tests fail, check the following:

■ JRE is installed on the server.

■ The file that maps URLs with JSP pages to the correct java servlets, 
web.xml, must be in the C:\Program Files\wfavvid\tomcat_
appadmin\webapps\ipphone\web-inf directory.

■ Find this entry in the registry: 

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\IPPA\
Config\TOMCAT HOME

Choose Edit > Modify, then type C:\Program Files\wfavvid\ 
tomcat_appadmin\ in the Value data field.

Problem The number and size of the log or debug files are smaller than specified 
in the application configuration file.

Symptom. The changed configuration file is copied to the $UCCX_
HOME/desktop/config directory using File Transfer Protocol (FTP) or 
other methods. The configuration file is not copied completely and thus 
the application uses the old or incomplete configuration file.

Solution Restart the CAD service after transferring the configuration file through 
FTP.
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Problem The Agent E-Mail, BIPPA, and Recording services are out of service.

This problem might be due to a setting in the Trend Micro OfficeScan 
antivirus software.

Solution To resolve this issue, in the Trend Micro OfficeScan software on the 
Unified CCX server, change the setting named “User Activity on Files, 
Scan files being:” from "created/modified and retrieved" to 
"created/modified".
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Chat Problems

Problem After completing a conference call, the Chat client and Supervisor 
Desktop show an extra party on the call.

Solution Occasionally, each agent receives different data from the CTI server. For 
example, a customer (555-5555) calls Agent A. The CTI server reports 
555-5555 as the calling number to Agent A. Agent A then conferences 
in Agent B. However, in this case the CTI server reports <Unavailable> 
as the customer number to Agent B. When the time comes to merge the 
data from the two agents (Agent A, Agent B, customer number, and 
<Unavailable>. an extra party is added because the customer number 
and <Unavailable> cannot be distinguished.
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Call/Chat Service Problems

Problem The following error occurs when trying to start the Call/Chat service: 

Could not start the Call/Chat Service on \\<computer> 
Error 2140: An internal Windows error occurred.

Solution Look at the Windows event log to see why the service failed to start.

1. Choose Start > Programs> Administrative Tools > Event Viewer.

2. Select Application in the tree control.

3. Look for messages that display FCCServer (the Call/Chat service) 
as the source. These messages should provide more information on 
the cause of the failure.

Problem How can I tell if the Call/Chat and LDAP Monitor services are running? 

Solution On the PC where the CAD services are installed, open the Services 
Control Panel. The following two services should be listed:

■ Cisco Desktop Call/Chat Service

■ Cisco Desktop LDAP Monitor Service

If the status of either service is not Started, select the service and click 
Start.
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Desktop Administrator Problems

Problem The following error appeared while attempting to install Desktop 
Administrator configuration files on a network drive:

“The drive does not support long file names. You must choose a drive 
that support long file names. See your network administrator for more 
information.”

Solution You must enable long file name support on the network drive, or choose 
another drive that does support them. You can also install the 
configuration files on the administrator PC. You must enable File 
Sharing If you install the configuration files on the administrator PC.

Problem The administrator cannot create a new work flow group. 

Solution The work flow group name is already used for another group, and/or the 
work flow group name is not a valid Windows directory name.

Problem When searching for subject matter experts from the Contact List page, 
no names are found, and this error message appears: “CDAUI2067 
search did not complete successfully, and only partial results are 
displayed. Contact technical support.”

Solution This error occurs when the parameters on the Unified Presence Cluster 
Settings page are not configured correctly. There are two possible 
causes of this problem: the user credentials are incorrect or the 
hostname/IP address is incorrect. 

NOTE:  The user specified on the Cisco Unified Presence Cluster 
Settings page must be able to perform SOAP queries and must 
be associated with the same profile in LDAP that agents are 
associated with.

To diagnose and resolve the problem, complete the following steps. 

1. Choose Cisco Unified Presence Settings > Cisco Unified Presence 
Cluster Settings.
94 August 6, 2012



Desktop Administrator Problems
2. Click Verify. 

■ If the hostname/IP address are incorrect, this error message 
appears: “CDAUI2033 Error communicating with the Unified 
Presence Server.”

■ If the user credentials are incorrect, this error message 
appears: “CDAUI2034 Invalid Cisco Unified Presence Cluster 
user credentials. Configured user must be able to run SOAP 
queries.”

3. Type the correct information in the appropriate fields, then click 
Verify to test the information you just entered. A message should 
appear, stating that the transaction was successful. 

4. Click Save.

Problem An SME can log into Cisco Unified Personal Communicator, but cannot 
set his/her own Presence status or see the Presence status of his/her 
contacts. The Unified Personal Communicator log files also list the error 
message “401 (Unauthorized).”

Solution This error occurs when the incoming Access Control List (ACL) in Unified 
Presence is not configured correctly. The ACL allows you to configure 
patterns that control which hosts and domains can access Unified 
Presence. To enable SMEs to access Unified Presence from Unified 
Personal Communicator, you must add an entry for "all" to the incoming 
ACL. 

To add the "all" entry as an incoming ACL, complete the following steps.

1. Log into Unified Presence Administration. 

2. Choose System > Security > Incoming ACL. The Find and List 
Allowed Incoming Hosts page appears.

3. Click Add New. The Incoming Access Control List Configuration page 
appears.

4. If desired, type a description of the address pattern in the 
Description field.

5. Type "all" in the Address Pattern field, then click Save.
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Problem A subject matter expert using a soft IP phone is not shown as on the 
phone when viewed by an agent running Agent Desktop.

Solution The Unified CM Session Initiation Protocol (SIP) publish trunk is not 
configured correctly.

To verify that the Unified CM SIP publish trunk is configured correctly, 
complete the following steps.

1. Log into Unified Presence Administration. 

2. Choose Presence > Settings. The Cisco Unified Presence Settings 
page appears.

3. Verify that the correct trunk is selected in the CUCM SIP Publish 
Trunk drop-down list.

NOTE:  You must select the Enable SIP Publish on CUCM check 
box to enable the CUCM SIP Publish Trunk parameter.

For more information about SIP trunks in Unified CM, see the Cisco 
Unified Communications Solution Reference Network Design (SRND) 
for Cisco Unified Communications Manager.

Problem A subject matter expert using a soft IP phone is not shown as busy 
when viewed by another subject matter expert running Unified Personal 
Communicator. 

Solution The Unified CM Session Initiation Protocol (SIP) publish trunk is not 
configured correctly.

To verify that the Unified CM SIP publish trunk is configured correctly, 
complete the following steps.

1. Log into Unified Presence Administration. 

2. Choose Presence > Settings. The Cisco Unified Presences Settings 
page appears.

3. Verify that the correct trunk is selected in the CUCM SIP Publish 
Trunk drop-down list.

NOTE:  You must select the Enable SIP Publish on CUCM check 
box to enable the CUCM SIP Publish Trunk parameter.
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For more information about SIP trunks in Unified CM, see the Cisco 
Unified Communications Solution Reference Network Design (SRND) 
for Cisco Unified Communications Manager.

Problem Agents cannot see SMEs.

Solution Perform the following checks.

■ If the agent has access to Cisco Unified Personal Communicator, 
verify that the agent can log into Unified Personal Communicator 
and see SMEs.

■ In Desktop Administrator, verify that the correct IP address for the 
Unified Presence server in the Cluster Configuration page is valid by 
clicking Verify.

■ Verify that at least one contact list containing one or more SMEs 
has been assigned to the work flow group to which the agent 
belongs.

■ Verify that the agent is running Agent Desktop and is logged into 
Unified Presence. To log in, click Chat, then choose File > Log In.

The File >Log In menu option is enabled only when the agent is 
logged out of Unified Presence and the server is up and running. 
This situation occurs only if (1) the agent’s Unified Presence 
username or password is different from the CAD username or 
password and (2) the agent clicks Cancel in the Login dialog box. 

If the agent is already logged into Unified Presence, the Log In 
menu option is disabled. If the Unified Presence server is down, the 
option is not available because when the server does come up, it 
tries to log the agent in automatically. If the automatic login fails the 
login dialog box is displayed, and if the agent cancels, the option 
will become available. 

Problem SMEs cannot see an agent or the agent's state is unknown.

Solution Perform the following checks.

■ Verify that the agent is in the SME's contact or buddy list.

■ Verify that the workflow group is configured to publish the agent's 
state.
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Problem After an agent or supervisor logs into Agent Desktop or Supervisor 
Desktop, an error message appears, stating that the login that was 
entered is not valid for Unified Presence.

Solution Agent Desktop and Supervisor Desktop automatically try to use the 
same credentials to log into Unified Presence that were used to log into 
the desktop application. If the Unified Presence credentials are 
different, the agent or supervisor will have to enter the credentials 
manually. An alternate solution is to use the same credentials for the 
Unified Presence server as the credentials for Agent Desktop or 
Supervisor Desktop.

Problem An agent cannot initiate a call to an SME in the Contact Selection 
window because the call control options in the Actions menu are 
inactive.

Solution Agent Desktop cannot retrieve the SME's phone number from Unified 
Presence. Verify that a phone number is configured for the SME in 
Unified Presence. You can find the number in the Active Directory that is 
associated with Unified Presence.

Problem An SME's presence status is displayed as Available in the Contact 
Selection window, even when the SME is already on a call. 

Solution Unified Presence is not configured to monitor the SME's phone status.

To configure Unified Presence to monitor phone status, complete the 
following steps.

1. Log into Unified CM Administration. 

2. Choose Device > Trunk. The Find and List Trunks page appears.

3. Verify that there is a trunk of type SIP Trunk and that the destination 
address of the trunk is the IP address of your Unified Presence 
server.

4. Choose Device > Phone. The Find and List Phones page appears.

5. Find and click the hyperlink for the device that corresponds to the 
SME's Unified Personal Communicator. The Phone Configuration 
page appears.
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6. Click the hyperlink for the directory number that is configured for 
the SME's device. The Directory Number Configuration page 
appears.

7. In the Users Associated with Line section, click Associate End 
Users. The Find and List Users page appears.

8. Select the user you want to associate with the directory number 
that is configured for the SME's device, then click Add Selected. The 
Directory Number Configuration page reappears and displays the 
user you just associated with this directory number.

9. Click Save to save your changes.

10. Log into Unified Presence Administration.

11. Choose Presence > Settings. The Cisco Unified Presence Settings 
page appears.

12. Verify that the CUCM SIP Publish Trunk is the same SIP trunk that is 
configured in Unified CM (step 3 above). 

Problem An agent is not receiving chat messages.

Solution This error occurs when an agent is logged into Unified Presence through 
two applications. An agent cannot be logged into Unified Presence 
through Unified Personal Communicator and through Agent 
Desktop/Supervisor Desktop at the same time, even if the usernames 
are different.

Problem When an agent receives a transferred call, the enterprise data is not 
correct.

Solution Call waiting is not supported in CAD. If call waiting is enabled, 
enterprise data might not be correct in certain circumstances. For 
example, if an agent is on a call and a new call is routed to that agent, if 
that agent transfers the original call to another agent, the second 
agent's desktop might display enterprise data for the new call, rather 
than the original call.
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Problem The enterprise data portion of the Contact Management pane in Agent 
Desktop is completely blank and does not display any information about 
the current call.

Solution This error can occur if one agent edits the layout name during a call and 
enters the name of a layout that does not exist, and then transfers the 
call to another agent. In this situation, the enterprise data portion of the 
Contact Management pane in the second agent's desktop will be 
empty.

Problem An administrator cannot record macros from Desktop Administrator.

Solution Some virus checkers might prevent the macro recorder from running. 
Disable all virus checkers on the administrator’s PC.

Problem An administrator cannot save changes made in Desktop Administrator; 
the Save button is disabled.

Solution Another user logged into Desktop Administrator first on the same 
server. The web application is locked to anyone except that first user. In 
order for another user to be able to save changes, the following must 
occur:

■ The first user logs out.

■ The first user’s session is inactive for 15 minutes, after which time 
Desktop Administrator automatically times out.

■ The first user closes the web browser without logging out, in which 
case Desktop Administrator is locked to all users for 15 minutes.

■ The first user navigates away from Desktop Administrator without 
logging out. If the first user returns to Desktop Administrator within 
15 minutes, that user is still logged in and can make changes. If the 
first user does not return to Desktop Administrator within 15 
minutes, after 15 minutes that user is logged out and another user 
can make changes.
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Desktop Work Flow Administrator Problems

Problem The administrator made some changes in Work Flow Setup, and then 
decided to cancel them. However, they were already saved.

Solution When a new action is created, any changes are automatically saved 
before returning to the Select Action dialog box. 

Problem The administrator cannot get a rule to work based on an internal 
extension number.

Solution When Agent Desktop compares the telephone numbers, if the dial 
string number format includes a leading x, then the telephone numbers 
in the list must also include a leading x.

Problem An action that launches an external application is not working correctly.

Solution Sometimes the operating system can be confused by spaces in 
directories and file names. If you have an application such as 
C:\Program Files\Acme\Search Database.exe /t/x. you might need to 
add quotes around the directory and executable. For example, the 
above would be “C:\Program Files\Acme\Search Database.exe” /t/x.

Problem When Agent Desktop attempts to launch an external application, the 
following error message appears: “Error Launching Application…The 
system cannot find the file specified.”

Solution When creating a launch external application action, you must include 
the extension of the application you wish to launch. For example, to 
launch Windows Notepad, C:\Windows\Notepad.exe is correct, while 
C:\Windows\Notepad is incorrect. 

If the path to the executable or an argument contains spaces, it must 
be enclosed in quotes, for instance, “C:\Program Files\MyFile.doc.”
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Problem The administrator configured a task button to send an e-mail message, 
and changed the hint to Send E-mail (Ctrl+S). The shortcut keys do not 
work.

Solution For any task button, you can only change the hint text. You cannot 
change the shortcut key.

Problem An automated blind transfer to a route point or port in a workflow action 
is failing because the device is not responding quickly enough. 

Solution Add a delay to the workflow action before the blind transfer occurs so 
that the device is ready and the operation can complete successfully.
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Enterprise Data Problems

Problem Enterprise data does not display data on outbound calls. 

Solution Enterprise data only displays data for inbound calls.

Problem Enterprise data does not display data for inbound calls.

Solution All devices the call goes through must be on the list of monitored 
devices (in Desktop Administrator, click Enterprise Data Configuration), 
or no data will be displayed. Make sure that the Enterprise service is 
properly installed and running. If everything appears to be working 
correctly, try rebooting the PC on which it is installed. After the PC has 
been rebooted, restart Agent Desktop on the agents’ desktops.

Problem Enterprise data displays data after a call has been dismissed.

Solution Enterprise data displays data from the last call until a new call is 
received. This allows agents to use the enterprise data for after-call 
work.
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Enterprise Service Problems

Problem How can I check to see if the Enterprise service is completely installed?

Solution Open the Services Control Panel. The following two services should be 
listed:

■ Cisco Desktop LDAP Monitor Service

■ Cisco Desktop Enterprise Service

If these services are not listed, reinstall the Enterprise service.

Problem How can I tell if the LDAP Monitor service is running?

Solution Open the Services Control Panel. Check the status of the LDAP Monitor 
service. If the status is not Started, select the service and click Start.

Problem How can I tell if the Enterprise service is running?

Solution Open the Services Control Panel. Check the status of the Enterprise 
service. If the status is not Started, select the service and click Start.

Problem When the user attempts to start Enterprise service, the following error 
displays:

Could not start the Cisco Enterprise Service on 
\\<computer>
Error 2140: An internal Windows error occurred.

Solution Look at the Windows event log to see why the service failed to start. 

1. Choose Start > Programs > Administrative Tools > Event Viewer.

2. On the Log menu, choose Application.

3. Select a message that displays Enterprise Server as the source. 
This should provide more information on the cause of the failure.
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Problem No screen pops appear when the user makes calls to and from devices.

Solution Try the following:

■ Use Enterprise Administrator to make sure the device is being 
monitored.

■ Check to see if CTI Server is running.

■ Check to see if an agent is logged in to the device.

■ Check if the device is configured on Unified CCX.

Problem Nothing happens when the user calls a particular device.

Solution Try the following:

■ Make sure the device is being monitored.

■ Check the event log to see if there are any error messages for the 
device.

Problem Incomplete or no enterprise data is displayed when an agent received a 
call.

Solution Try the following:

■ Check if the device is being monitored in the Enterprise service.

■ Set debug threshold to DEBUG. Stop and restart Agent Desktop. 
Repeat the call scenario, and then check ssctihandler.dbg for 
warnings about non-monitored devices. Search for “monitoring” in 
the debug file.

Problem When the user attempts to start Enterprise service, the following error 
displays:

Could not start the Cisco Desktop Enterprise Service on 
\\<computer>
Error 2140: An internal Windows error occurred.

Solution Look at the Windows event log to see why the service failed to start. 
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1. Choose Start > Programs > Administrative Tools > Event Viewer.

2. On the Log menu, choose Application.

3. Select a message that displays Enterprise Server as the source. 
This should provide more information on the cause of the failure.
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Installation Problems

Problem The Agent Desktop services have been upgraded from version 6.4(1) to 
version 6.6 (1), and Automatic Updates are enabled. The Agent Desktop 
applications should automatically update the next time they are started. 
However, some desktops do not upgrade so there are mixed Agent 
Desktop versions operating in the contact center.

Solution The desktops that have not automatically upgraded must be upgraded 
individually from the Unified CCX Administration web application. See 
the Cisco CAD Installation Guide for more information.
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IP Phone Agent Problems

Problem Agents do not see the IP Phone Agent service on their IP phones.

Solution The following are some reasons for the service to not appear when the 
Services menu is accessed:

■ The IP Phone Agent service has not been configured in Unified CM.

■ The phone is not subscribed to the IP Phone Agent service.

■ The service URL in Unified CM has a hostname and the phone 
cannot resolve it. Use the IP address instead.

■ The phone has not been rebooted after changes were made in 
Unified CM. If a soft reboot does not work, try a hard reboot (unplug 
the phone’s power cord and then plug it back in).

Problem Agents see an HTTP error when selecting the IP Phone Agent service on 
their phone.

Solution Some solutions:

■ The IP Phone Agent service URL in Unified CM has a hostname and 
the phone cannot resolve it. Use the IP address instead.

■ The IP Phone Agent service URL in Unified CM has an incorrect 
hostname, IP address, or port. The port is specified in 
<Parameter name=”port” value=”6293”/> under the section 
<!-- Normal HTTP --> in C:\Program Files\wfavvid\tomcat_
appadmin\conf\server.MADM.xml.

■ The IP Phone Agent service URL is case sensitive. Enter it exactly as 
specified in the Cisco CAD Installation Guide.

■ The Tomcat service is not running on the CAD services computer.

■ The BIPPA service is not running on the CAD services computer.

■ The agent’s phone was not rebooted after changes were made in 
Unified CM. If a soft reboot does not work, try a hard reboot (unplug 
the power cord and plug it back in).
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Problem The agent sees an error message that the IP Phone Agent service is not 
active.

Solution Some solutions:

■ The system is set up with redundant CAD services and the agent 
has selected the standby IP Phone Agent service instead of the 
active service. For redundant CAD services, there should be two IP 
Phone Agent services set up in Unified CM, each pointing to a 
different BIPPA service, and all IP Phone Agent agent phones must 
be subscribed to both services. 

■ On a nonredundant system, if the LRM service is down, then the 
BIPPA service will become standby. Restart the LRM service.

■ Agent Desktop or Supervisor Desktop was installed on the same 
computer as the CAD services. They clear a registry key (IOR 
Hostname under Site Setup) required by the BIPPA service. Set the 
registry to the IP address of the CAD services computer.

Problem The agent gets the Force Login screen when trying to log in, but 
attempting to force the login does not work.

Solution The agent is using an agent ID that is already logged in on another 
extension, or using an extension that is already logged in with a 
different agent ID. Forced logins work only for the same ID/extension 
pair. Use a different agent ID or extension, or find the other user and 
have them log out.

Problem The agent does not see the Enterprise Data screen when 
receiving/answering a call, receive Skill Statistics screen updates, or 
see the Wrapup screen.

Solution Some solutions:

■ The authentication URL in Unified CM has a hostname and the 
phone could not resolve it. Use the IP address instead.

■ If the Unified CM authentication URL (one with authenticate.jsp) is 
used, make sure that the correct BIPPA user and password, as 
specified in CAD Configuration Setup, exists in Unified CM and that 
the phone is associated with this user.
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■ The agent’s phone was not rebooted after changes were made in 
Unified CM. If a soft reboot does not work, try a hard reboot (unplug 
the power cord and plug it back in).

■ Verify that the agent is logged in to the phone.

■ Verify that if the agent logs into Agent Desktop using the same 
phone and user ID, enterprise data does pop correctly.

Problem The agent sees nonsense characters in reason code or wrapup data.

Solution The reason codes or wrapup data configured in Desktop Workflow 
Administrator contain characters not supported by the phone. Examples 
are multibyte Chinese or Kanji characters. Make sure that no 
unsupported characters are used when configuring reason codes and 
wrapup data.

Problem A supervisor cannot record or monitor an IP Phone Agent agent.

Solution For troubleshooting information about VoIP monitoring and recording, 
see Configuring and Troubleshooting VoIP Monitoring.
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LDAP Monitor Problems

Problem Slapd.exe is not running even though the LDAP Monitor service is 
running.

Solution Do the following:

■ Verify the settings in the file slapd.cfg in the folder C:\Program 
Files\Cisco\Desktop\config.

■ Verify there are no other instances of slapd.exe are running.

■ Verify that the C:\Program Files\Cisco\Desktop\database folder 
contains 7 files with a *.dat extension and DB_CONFIG. If these are 
missing, copy them from another system or reinstall the CAD 
services.

■ Make sure the C:\Program Files\Cisco\Desktop\database folder 
contains log.*, __db.* and 8 files with a *.bdb extension. If not, 
follow the procedure in "Out of Sync Directory Services Databases" 
on page 46, copying from the one that works to the one that does 
not. Otherwise, you will need to reinstall the CAD services.

■ Get more information about why slapd.exe cannot start by 
completing the following steps:

a. Stop the LDAP Monitor service.

b. Open a DOS command window and navigate to the C:\Program 
Files\Cisco\Desktop\bin folder.

c. Type slapd.exe -f slapd.cfg and press Enter.

d. If it aborts, use the resulting error messages to diagnose the 
problem. 

e. If it runs successfully, type Ctrl+C to end it. 

f. Verify the settings in the file LDAPMonSvr.cfg in the folder 
C:\Program Files\Cisco\Desktop\config, including the 
arguments for slapd.exe.

Problem Clients are unable to connect to the LDAP service.

Solution Some solutions:
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■ The wrong IP addresses are set for LDAP Host 1 and/or LDAP Host 
2 in the registry.

■ The LDAP Monitor service is not running. Start it.

■ Check if slapd.exe is running. If it is not running, follow the 
troubleshooting steps for this problem.

■ The LDAP database is corrupted. Follow the steps outlined in 
"Corrupted Directory Services Database" on page 45.

Problem Clients do not find the same information from LDAP after failing over 
from one LDAP to the other.

Solution Some solutions:

■ Ensure replication is set up correctly.

■ Check that registry entries for LDAP Host 1 and 2 on both CAD 
services computers are the same and contain the right information.

■ Check that slapd.conf on both CAD services computers are correct 
and reference each other.

■ If all else fails, follow the steps outlined in "Out of Sync Directory 
Services Databases" on page 46.

Problem When setting up replication, one or more files containing the LDAP 
database is not copied from Side A to Side B.

Solution One or more of the files that make up the LDAP database on Side A is 
not fully copied over to Side B. The customer experiences the following:

■ When Side A goes down (or is restarted) and clients fail over to Side 
B, users can’t connect to LDAP, even though it might appear that 
slapd is running.

■ In the log file for LdapMonSvr, the following line is found:

Failed to send file

Do not attempt to correct this yourself. Call Technical Support. 
(Technical Support: Use LdapUtil with the /S option to re-setup 
replication.)
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Recording and Statistics Service Problems

Problem When trying to view agent state or call logs, no data is presented.

Solution The agent might not have received a call, or logged in for that particular 
day. The agent’s or supervisor’s PC’s clock might not be in the correct 
time zone.

NOTE:  All state and call times are based on server time.

Problem Data appears to be in incorrect chronological order in Agent Desktop or 
Supervisor Desktop logs and reports, or in Supervisor Record Viewer. 
Unified CCX is in a redundant configuration, and a failover just 
occurred.

Solution If the system clocks on the redundant Unified CCX servers are not 
synchronized, report and log data will appear to be in the wrong order 
after a failover from one server to the other. To correct this situation, 
use a network time service to automatically synchronize all server 
system clocks, or manually adjust them so that they are in sync.
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Recording and Monitoring Problems

For troubleshooting information about VoIP monitoring and recording, see Configuring 
and Troubleshooting VoIP Monitoring.
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Supervisor Desktop Problems

Problem Error when trying to select skills in the Team View pane.

Symptom. When you try to select skills in the Team View pane in the 
Supervisor Desktop, the following message appears:

Message. Agent Desktop must be active before call intervention, call 
recording, and queue stats are available.

Cause. To view skill group statistics, you must log into Agent Desktop 
using your supervisor login.

Solution Log into Agent Desktop using your supervisor login.

Problem Display of agents in Supervisor Desktop.

Symptom. The following symptoms related to the display of agents in 
the Supervisor Desktop can occur:

■ Agents disappearing from Supervisor Desktop

■ Agent not listed in Supervisor Desktop

■ Supervisor Desktop does not display any agent

Cause. Incorrect configuration or IP connectivity issues between the 
agent and the Unified CCX system or the Unified CCX system and the 
supervisor.

Solution Complete the following steps:

1. Verify that the agent belongs to the team that the supervisor is 
monitoring. Refer to the section about team configuration in the 
Cisco Desktop Administrator User Guide.

2. Verify that all instances of Agent Desktop and Supervisor Desktop 
have been upgraded to the same version as the CAD services 
running on the Unified CCX server.

3. Determine whether the supervisor’s PC or agent’s PC has multiple 
NICs. 

4. Determine whether any ports in the 59000–59030 range are 
blocked by a firewall.
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5. Go to Local Area Connection settings > Advanced tab to determine 
if the agent’s PC or supervisor’s PC, running on Windows XP, has 
the Internet Connection Firewall enabled.

6. To test for blocked ports, use telnet from the command line as 
follows with agent and supervisor logged in:

■ From the Chat service to agent, type the following command.
telnet <agent PC IP address> 59020

■ From the Chat service to supervisor, type the following 
command. 
telnet <supervisor PC IP address> 59021

■ From agent to the Chat service, type the following command.
telnet <Unified CCX server IP address> 59000

If you get a “failed to connect” error, then you need to determine 
why the port is blocked.

Problem The agent’s state changed to Not Ready for no apparent reason.

Symptom. In some situations, an agent’s state may change to Not 
Ready for no apparent reason.

Cause. To determine the reason, check the reason code:

■ If the reason code is 32763, the agent’s state became Not Ready 
because of Ring No Answer (RNA). If the agent phone is configured 
on Unified CM with auto-answer enabled, then this is likely a 
Unified CM issue since the call is not answered in time. Please 
consult Unified CM support.

■ If the reason code is 32759, the agent’s state became Not Ready 
because the phone went out of service. Check to make sure the 
phone is still functional and that you can call the phone directly. If 
everything seems fine, it is most likely a temporary problem and the 
phone has since recovered. If the phone is still down, it is most 
likely a Unified CM problem. Please consult Unified CM support.

■ If the reason code is 32757, the agent’s state became Not Ready 
because the phone rehomed due to a Unified CM failover. As long 
as the agent is able to go Ready after the failover, this is not an 
issue.

Solution In many cases, an agent’s state becoming Not Ready is not a serious 
issue. Simply click Ready to change the agent’s state to Ready.

To determine the reason code, do one of the following:
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■ Open the Agent State Report. From Agent Desktop, click Reports. 
Select Agent IPCC Express State Log. Look for the entry which says 
“Not Ready” at the time the agent’s state became Not Ready. 
Check the reason code for this entry.

■ Run the Agent State Detail Report, a Unified CCX Historical Report, 
and look for the “Not Ready” entry of the agent at the time the 
agent went to Not Ready state. Check the reason code for this 
entry.

In situations where the agent cannot change state to Ready because 
the phone is still down, contact Unified CM support.

Problem Agents who connect to the contact center through a VPN are not 
displayed in the Supervisor Desktop Team View pane. The agents 
disappeared from the Team View pane after disconnecting and then 
reconnecting to the VPN. The status bar displays “In Service.”

Solution If either agents or supervisors use a VPN connection, their desktops 
must be restarted after disconnecting and then reconnecting to the 
VPN. 

Problem A supervisor using Windows XP was able to start Supervisor Desktop, 
but was not able to load a team or display any agent information.

Solution Windows XP can be configured so that the Internet Connection Firewall 
(ICF) is active. ICF acts by keeping track of all traffic to and from the 
computer; it will only allow information through that has originated from 
that particular computer. If a message originates from outside the 
computer, it will be discarded. 

To solve this problem, either turn off ICF (requires someone with 
administrator rights to the computer) or override the defaults to include 
known “good” connections like the Agent Desktop servers.

Problem When the supervisor clicks on an agent to start monitoring, Supervisor 
Desktop displays the speaker icon next to the call but there is no sound.

Solution For troubleshooting information about VoIP monitoring and recording, 
see Configuring and Troubleshooting VoIP Monitoring.
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Problem The supervisor cannot log into the VoIP Monitor service, and receives 
the error “Could not access sound card.”

Solution For troubleshooting information about VoIP monitoring and recording, 
see Configuring and Troubleshooting VoIP Monitoring.

Problem The sound quality is poor, and sounds choppy like a motorboat.

Solution For troubleshooting information about VoIP monitoring and recording, 
see Configuring and Troubleshooting VoIP Monitoring..

Problem The sound is lagged. There is a noticeable delay between when the 
agent speaks and when the supervisor hears the sound on the PC 
sound card.

Solution For troubleshooting information about VoIP monitoring and recording, 
see Configuring and Troubleshooting VoIP Monitoring.

Problem The supervisor doesn’t see any of his teams or other personalized 
settings in the Supervisor Desktop window. 

Solution If you add Supervisor Desktop to your Startup menu and your 
configuration files are on a network, it is possible that your 
configuration files aren’t loaded before Supervisor Desktop starts 
because your PC hasn’t had time to map the network drives. As a result, 
your personalized settings will not show.

Close Supervisor Desktop and start it again, and your personal settings 
will be loaded. To avoid the problem in the future, remove Supervisor 
Desktop from the Startup menu, and create a desktop shortcut icon to 
use to start the program.

Problem The supervisor scrolled the Data View (or Message View) pane sideways 
to view more information, and the toolbar icons disabled.

Solution Click anywhere in the Team View pane to enable the toolbar again.
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Problem The supervisor clicked Record to record an agent conversation and 
nothing happened.

Solution For troubleshooting information about VoIP monitoring and recording, 
see Configuring and Troubleshooting VoIP Monitoring. 

Problem The supervisor tried to change an agent’s state and nothing happened.

Solution There is no visible message displayed if an agent state change request 
fails. If nothing happens, assume that the request failed. You will know 
that an agent state change succeeds if the icon next to the agent’s 
name in the Team View pane changes to the current agent state icon.

Problem Supervisor Desktop is no longer displaying any skills statistics.

Solution The supervisor is also an agent logged into the ACD. If the supervisor is 
inactive (in the Not Ready state) long enough he or she is logged out of 
the ACD. 

The supervisor should log back in to see skills statistics again. A 
workaround to the logout situation is to create a skill group that has 
only supervisors in it and that does not receive ACD calls. The 
supervisors can then place themselves in the Ready state and remain 
logged in as long as necessary.

Problem The supervisor clicks a recording, but it does not play.

Solution For troubleshooting information about VoIP monitoring and recording, 
see Configuring and Troubleshooting VoIP Monitoring.

Problem After completing a conference call, the Chat client and Supervisor 
Desktop show an extra party on the call.

Solution Occasionally, each agent receives different data from the CTI server. For 
example, a customer (555-5555) calls Agent A. The CTI server reports 
555-5555 as the calling number to Agent A. Agent A then conferences 
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in Agent B. However, in this case the CTI server reports <Unavailable> 
as the customer number to Agent B. When the time comes to merge the 
data from the two agents (Agent A, Agent B, customer number, and 
<Unavailable>. an extra party is added because the customer number 
and <Unavailable> cannot be distinguished.

Problem If the supervisor’s hook state changes during Call/Chat service failure 
and recovery, the Barge-In and Intercept buttons get out of sync in 
Supervisor Desktop.

Solution Once the supervisor takes another call after the Call/Chat service 
recovers, the Barge-In and Intercept buttons will display correctly. The 
problem can also be corrected by restarting Supervisor Desktop.

Problem Supervisors are getting randomly logged out of the Call/Chat service.

Solution If a supervisor attempts to log into the Call/Chat service with the same 
ID as another supervisor, the Call/Chat service logs the first supervisor 
out. To avoid this problem, make sure that each supervisor has a 
unique ID. The ID is the extension stored in Phonedev.ini (located in the 
config folder). Phonedev.ini is populated with the extension field from 
the Login dialog box when Agent Desktop is started.

Problem The supervisor starts recording an agent’s conversation, but after a 
short time the recording stops by itself.

Solution Check to make sure that no other supervisors are currently viewing the 
same team of agents. Any supervisor using Supervisor Desktop can see 
all conversations being recorded, and can stop a recording of an agent 
conversation even if that supervisor did not initiate the recording.

Problem The supervisor is viewing a blind conference call, but cannot see all 
parties on the call.

Solution In CAD 7.0, a blind conference is defined as adding an alerting party to 
a conference. All parties on a blind conference call might not show up in 
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either Supervisor Desktop, CAD-BE, or Agent Desktop. This is a 
limitation of the CTI service software.

Problem When monitoring an agent’s customer contact, nothing can be heard, 
and after 15 seconds, an error message is received that no packets are 
being received. Attempting to record an agent’s customer contact 
results in an empty recording. The agent’s desktop is monitored using 
desktop monitoring.

Solution The following device settings are required for desktop monitoring to 
function correctly with CAD. The settings are configured with the 
Unified CM Administration application.

NOTE: Not all devices or Unified CM versions use all these settings. 
Configure those that do appear for your device and Unified CM version.

In the Product Specific Configuration section of the Device 
Configuration screen, configure these settings as follows:

■ PC Port—Enabled. If the PC Port is not enabled, the agent PC that is 
connected to the port will not have network access. No voice 
streams will be seen by the desktop monitor module.

■ PC Voice VLAN Access—Enabled. If the PC Voice VLAN Access is not 
enabled, no voice streams will be seen by the desktop if the 
desktop is not a member of the same VLAN as the phone.

■ Span to PC Port—Enabled. If the Span to PC Port is not enabled, the 
voice streams seen by the phone will not be seen by the desktop 
monitor module.

In the Device Information section of the Device Configuration screen, 
configure this setting as follows:

■ Device Security Mode—Non-Secure or Authenticated. If the Device 
Security Mode is set to Encrypted, the voice streams can be seen 
but will not be converted correctly, causing the speech to be 
garbled.

You must also configure the agent phones to use the G.711 or G.729 
codecs. Other codecs, such as G.722, are not supported for silent 
monitoring and recording.
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Problem After an upgrade, the Report Font Size field is blank in the Preferences 
dialog box in Supervisor Desktop.

Solution Select a font size from the drop-down list. The minimum report font size 
is 15. 

Problem A supervisor’s screen reader is not reading the contents of table cells in 
reports.

Solution Text in reports might not be readable initially by screen readers. Consult 
your screen reader’s documentation for information on forcing the 
program to read text in report cells.

Problem A supervisor logs out a CAD agent, and the agent still appears in the list 
of agents in Supervisor Desktop. The supervisor logs out a CAD-BE 
agent, and the agent disappears from the list of agents in Supervisor 
Desktop. 

Solution This is normal behavior for CAD-BE. 
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Sync Service Problems

Problem How can I tell if the Sync service is running properly?

Solution In Desktop Administrator, perform a manual synchronization for a 
specific logical contact center. Make sure that all agents, supervisors, 
and teams are correctly listed for that logical contact center.

Problem The message, "At least one or more errors occurred during 
synchronization" appeared when the administrator performed 
synchronization in Desktop Administrator.

Solution Check the Sync service log file. If the logged error points to a problem 
with the Acmi connection, look for problems with the CTI server. Also 
look for similar problems in the Enterprise server logs. If the logged 
error points to an LDAP error, make sure the LDAP service is running 
and the LDAP Host 1 registry setting in the following file has the correct 
value: HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\CAD\SiteSetup.
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Unified CCX License Administration Problems

Problem The message, “There are no licenses available. Please contact your 
Administrator for help,” appears.

Solution All licenses are currently in use. Contact your sales representative to 
obtain additional licenses.

Problem Real-time reports shows the number of resources logged in, but it does 
not show the number of supervisors who are currently logged in. How 
can I view the number of supervisors who are currently logged in?

Solution To view the IP addresses of clients that are consuming desktop seats or 
are running a CAD administration application, run the 
ShowLicenseUsage utility from the Cisco\Desktop\bin folder on your 
CAD server.

Note that for IP Phone Agent and CAD—Browser Edition seats, the 
IP address is the IP address of the active Browser and IP Phone Agent 
(BIPPA) service. For web-based Cisco Desktop Administrator, the 
IP address is the IP address of the CAD server.
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VoIP Monitor Problems

Problem The CPU usage on the VoIP Monitor service PC has gone to 99%, and 
the PC has locked up.

Solution This can happen when you disable the sniffing adapter through the 
Windows Network and Dialup Connections window while the VoIP 
Monitor service is running. Re-enabling the sniffer adapter while the 
VoIP Monitor service is running will not solve the problem. You must 
stop the VoIP Monitor service, re-enable the sniffer adapter, and then 
restart the VoIP Monitor service to restore normal functionality. 

Problem Voice traffic generated by Desktop Monitoring, the VoIP Monitor service, 
and the Recording service is not tagged for QoS (quality of service).

Solution Winsock QoS is disabled for Windows XP and Server 2000/2003 by 
default, and must be enabled through the Windows registry.

Follow these steps to enable the QoS Setting for VoIP Monitor services 
on Windows XP or Windows Server 2003: 

If you are running Windows XP or Windows Server 2003: 

1. In the Registry Editor, under HKEY_LOCAL_MACHINE, access

SYSTEM\CurrentControlSet\Services\TcpIp\Parameters 

7. Choose Edit > New > DWORD Value. 

8. Type DisableUserTOSSetting as the entry name, then press Enter. 
When you add this entry, the value is set to 0 (zero). Do not change 
the value. 

9. Quit Registry Editor, and then restart the computer. 

Problem The VoIP Monitor service fails with the following exception when using 
server-based monitoring:

FATAL FCVMS112 splk_pcap_open_live() failed. errorBuf = Error 
opening adapter: Access is denied.
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Conditions: A second NIC is installed/enabled on the server. CAD 
Configuration Setup is run to detect the second NIC and then the VoIP 
Monitor service is restarted.

Solution The splkpcap driver must be reinitialized. To do this, unload and then 
reload the driver. Open a command window on the computer where the 
new NIC was installed and type these commands:

net stop spcd 
net start spcd

Close the command window and start CAD Configuration Setup. In the 
VoIP Monitor Service window, select the IP address of the new NIC and 
save the changes.
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